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Résumé

Les simulations de Monte Carlo sont actuellement considérées en imagerie de médecine nu-
cléaire comme un outil pour concevoir et optimiser la caméra à scintillation et les systèmes
SPECT, ainsi que pour évaluer algorithmes de reconstruction et méthodes de correction pour
dégrader les effets physiques. Parmi les de nombreux simulateurs disponibles, aucun d’entre
eux n’est considéré comme un standard en imagerie médicale nucléaire. Dans cette thèse, nous
avons utilisé le code de simulation de Monte Carlo, SIMIND, qui décrit une caméra SPECT
standard et peut facilement être modifié pour presque n’importe quel type de calcul rencontré
en imagerie SPECT. SIMIND a été validé dans SPECT en modélisant des gamma caméras, en
comparant les résultats obtenus avec des simulations SIMIND avec des données expérimen-
tales. SIMIND comprend une modélisation complète des interactions des collimateurs, ce qui
est essentiel lorsque des émetteurs de photons de plus haute énergie sont simulés. Notre objec-
tif dans ce travail de thèse était d’évaluer et de déterminer les paramètres d’imagerie optimaux
en imagerie SPECT, et également d’évaluer la méthode TEW, au moyen de la simulation de
Monte Carlo. Une méthode largement utilisée pour la correction de la diffusion est la sous-
traction d’images formées à l’aide de fenêtres d’énergie dans la région des photopointes. Les
paramètres utilisés pour la comparaison des différents paramètres de fenêtre et collimateurs
incluent; résolution spatiale, sensibilité, contraste de l’image, rapports diffusion / total (STR).
Nous avons évalué les paramètres d’imagerie pour l’I-131 en utilisant la simulation de Monte
Carlo. Nous avons démontré que, dans I-131 SPECT, la diffusion et la pénétration du colli-
mateur sont significatives et nos résultats montrent que, le petit angle d’acceptation a un effet
majeur sur la qualité de l’image en imagerie I-131 SPECT. En outre, un certain nombre de
paramètres de fenêtre d’énergie et de collimateur différents pour les isotopes I-131, Lu-177,
Y-90 sont étudiés en utilisant des simulations de Monte Carlo avec le code SIMIND. De plus,
nous évaluons les fractions de photons diffusés et déterminons les fenêtres optimales de sous-
énergie et d’énergie principale pour la mise en uvre de la méthode de correction TEW en
imagerie Sm-153.

Mots-clés tomographie par émission monophotonique (SPECT), imagerie nucléaire, Monte
Simulation de Carlo, SIMIND, sensibilité, résolution spatiale, photon diffusé
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Summary

Monte Carlo simulations are currently considered in nuclear medicine imaging as a powerful
tool to design and optimize the scintillation camera and SPECT systems, and also to assess
reconstruction algorithms and correction methods for degrading physical effects. Among the
many simulators available, none of them is considered as a standard in nuclear medical imag-
ing. In this thesis we have used the Monte Carlo simulation code, SIMIND, which describes
a standard SPECT camera and can easily be modified for almost any type of calculation en-
countered in SPECT imaging. SIMIND was validated in SPECT by modeling gamma cameras,
by comparing the results obtained with SIMIND simulations with experimental data. SIMIND
includes complete modeling of collimator interactions, which is essential when higher energy
photon emitters are simulated. Our objective in this thesis work was to evaluate and determine
the optimal imaging parameters in SPECT imaging, and also evaluate of TEW method, by the
means of Monte Carlo simulation. A widely used method for scatter correction is subtraction
of images formed using energy windows in the region of the photopeaks. Parameters used for
comparison of the different window settings and collimators include; spatial resolution, sensi-
tivity, image contrast, scatter to total ratios (STR). We have evaluated the imaging parameters
for I-131 using Monte Carlo simulation. We demonstrated that, in I-131 SPECT, the collimator
scatter and penetration are significant and our results show that, the small acceptance angle has
a major effect on the image quality in I-131 SPECT imaging. In addition, a number of different
energy window settings and collimator for the isotopes I-131, Lu-177, Y-90 are investigated
using Monte Carlo simulations with the code SIMIND. Also, we assess the scattered photon
fractions and determined the optimal sub- and main-energy windows for the implementation of
TEW correction method in Sm-153 imaging.

Keywords single-photon emission computed tomography (SPECT), nuclear imaging, Monte
Carlo simulation, SIMIND, sensitivity, spatial resolution, scattered photon
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Résumé détaillé

La tomodensitométrie à émission monophotonique (SPECT Scan) est une technique d’imagerie
tomographique de médecine nucléaire utilisant des rayons gamma. Elle est très similaire à
l’imagerie planaire de médecine nucléaire conventionnelle utilisant une caméra gamma. Cepen-
dant, il peut fournir des informations en 3D sous la forme d’images en coupe transversale
du patient, par exemple l’imagerie cérébrale. Les systèmes d’imagerie informatique peuvent
transformer ces informations pour produire l’image requise. Dans l’ensemble, la technique
nécessite l’administration d’un radionucléide émetteur gamma au patient, normalement par in-
jection dans la circulation sanguine. Depuis le développement de la tomodensitométrie dans
les années 1970, le radioisotope de l’organe et / ou du tissu peut être cartographié par imagerie
SPECT. Tous les rayonnements gamma émis par les produits radiopharmaceutiques SPECT
sont détectés par l’utilisation d’une caméra gamma rotative autour du patient pour produire une
imagerie 3D. Les images subissent diverses transformations électroniques en tenant compte
de la distribution du radiotraceur, du processus de rétroprojection filtrée et d’autres techniques
tomographiques. Les simulations de Monte Carlo sont actuellement considérées en imagerie
de médecine nucléaire comme un outil puissant pour concevoir et optimiser la caméra à scin-
tillation et les systèmes SPECT, ainsi que pour évaluer les algorithmes de reconstruction et
les méthodes de correction des effets physiques dégradants. Parmi les nombreux simulateurs
disponibles, aucun d’entre eux n’est considéré comme un standard en imagerie médicale nu-
cléaire. Dans cette thèse, nous avons utilisé le code de simulation de Monte Carlo, SIMIND,
qui décrit une caméra SPECT standard et peut facilement être modifié pour presque n’importe
quel type de calcul rencontré en imagerie SPECT. SIMIND a été validé dans SPECT en mod-
élisant des gamma caméras, en comparant les résultats obtenus avec des simulations SIMIND
avec des données expérimentales. SIMIND comprend une modélisation complète des inter-
actions des collimateurs, ce qui est essentiel lorsque des émetteurs de photons de plus haute
énergie sont simulés. Notre objectif dans ce travail de thèse était d’évaluer et de déterminer les
paramètres d’imagerie optimaux en imagerie SPECT, et également d’évaluer la méthode TEW,
au moyen de la simulation de Monte Carlo. Une méthode largement utilisée pour la correction
de la diffusion est la soustraction d’images formées à l’aide de fenêtres d’énergie dans la ré-
gion des photopointes. Les paramètres utilisés pour la comparaison des différents paramètres de
fenêtre et collimateurs incluent; résolution spatiale, sensibilité, contraste de l’image, rapports
diffusion / total (STR). Nous avons évalué les paramètres d’imagerie pour l’I-131 en utilisant
la simulation de Monte Carlo. Nous avons démontré que, dans I-131 SPECT, la diffusion et
la pénétration du collimateur sont significatives et nos résultats montrent que, le petit angle
d’acceptation a un effet majeur sur la qualité de l’image en imagerie I-131 SPECT. En outre,
un certain nombre de paramètres de fenêtre d’énergie et de collimateur différents pour les iso-
topes I-131, Lu-177, Y-90 sont étudiés en utilisant des simulations de Monte Carlo avec le code
SIMIND. De plus, nous évaluons les fractions de photons diffusés et déterminons les fenêtres
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Résumé détaillé

optimales de sous-énergie et d’énergie principale pour la mise en uvre de la méthode de correc-
tion TEW en imagerie Sm-153. The Monte-Carlo simulations are a widely and effective tool
for different areas of diagnostic nuclear imaging, such as, the optimization of detector compo-
nents (collimator, scintillator, photomultiplier ...), the design of new detectors . The method is
useful for solving complex problems when experimental measurements may be impracticable.
The design of SPECT and PET (Positron emission tomography) imaging systems using the
Monte Carlo technique has received considerable attention, and a large number of applications
were the result of such investigations. Another promising application of Monte Carlo calcula-
tions is the development and evaluation of reconstruction algorithms and correction technique
for attenuation and scattered photons which degrade contrast, spatial resolution, and quantifica-
tion, since with Monte Carlo Simulation, it is possible to track and record the life history of the
individual photon originating from the source that ultimately deposits its complete energy in-
side the crystal. Therefore, unscattered and scattered photons can be tracked separately. Monte
Carlo simulation thus allows a detailed evaluation of the energy and spatial distribution of scat-
tered photon, which would be difficult to perform using experimental study . Many simulators
are currently available, but none of them has yet become a standard in nuclear imaging because
each has its own specificities and also its own shortcomings. In this work we use the SIMIND
Monte Carlo code , which is well established for SPECT with low-energy photons. Because of
the interest in simulating higher energy photon emitters, this code was recently combined with
the collimator routine that accounts for scatter and penetration. The SIMIND code is designed
such that the parameters to be calculated in a particular simulation can be easily changed. This
is achieved through a user-written scoring subroutine that is linked to the code. A call to the
routine is made at different stages during a photons history. Several scoring routines were used
to generate the images and spectra that were specific to this work. In, SPECT imaging, the
quantification is difficult for common nuclear medicine isotopes because of the higher energy
of the photopeak and the multiple γ-ray emissions . Therefore, the inclusion of scattered pho-
tons in SPECT images degrades spatial resolution, and contrast . In the case of higher energy
photon emitters such as I-131, both septal penetration and scatter in the collimator are signif-
icant . The SIMIND Monte Carlo code [5] used in this work includes complete modeling of
collimator interactions, which is essential when higher energy photon emitters are simulated
. Our objective in this thesis work was to evaluate and determine the optimal imaging param-
eters in SPECT imaging by the means of Monte Carlo simulation . Le chapitre I rappelle le
principe général de l’imagerie gamma, décrivant les radiotraceurs, la chaîne de détection et
les types d’acquisition de gamma caméra. Les limites du SPECT, résultant principalement de
facteurs technologiques et physiques, sont enfin abordées: les phénomènes majeurs perturbant
la formation d’images tels que l’atténuation et la diffusion sont décrits. Ce chapitre présente
également le rayonnement électromagnétique, la spectrométrie du rayonnement électromag-
nétique et les méthodes de correction SPECT développées pour corriger les phénomènes de
dégradation de l’image et empêcher une quantification précise et fiable des coupes reconstru-
ites. Le chapitre II est consacré au problème de la reconstruction tomographique et décrit les
principaux algorithmes de reconstruction utilisés dans SPECT. Le chapitre III rappelle les rôles
principaux de la simulation de Monte Carlo en imagerie de médecine nucléaire, puis décrit le
programme SIMIND Monte Carlo et les différentes étapes à suivre pour effectuer une simu-
lation sont exposées. Dans le chapitre IV, nous évaluons les fractions de photons pénétrés et
diffusés dans la fenêtre d’énergie de photopics pour l’I-131 en utilisant le code de simulation de
Monte Carlo. Chapitre V Ce chapitre propose d’évaluer la distribution de dispersion du Lu-177
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Résumé détaillé

afin de déterminer la situation optimale pour la qualité d’image. La tomodensitométrie à émis-
sion monophotonique (SPECT Scan) est une technique d’imagerie tomographique de médecine
nucléaire utilisant des rayons gamma. Elle est très similaire à l’imagerie planaire de médecine
nucléaire conventionnelle utilisant une caméra gamma. Cependant, il peut fournir des informa-
tions en 3D sous la forme d’images en coupe transversale du patient, par exemple l’imagerie
cérébrale. Les systèmes d’imagerie informatique peuvent transformer ces informations pour
produire l’image requise. Dans l’ensemble, la technique nécessite l’administration d’un ra-
dionucléide émetteur gamma au patient, normalement par injection dans la circulation san-
guine. Depuis le développement de la tomodensitométrie dans les années 1970, le radioisotope
de l’organe et / ou du tissu peut être cartographié par imagerie SPECT. Tous les rayonnements
gamma émis par les produits radiopharmaceutiques SPECT sont détectés par l’utilisation d’une
caméra gamma rotative autour du patient pour produire une imagerie 3D. Les images subissent
diverses transformations électroniques en tenant compte de la distribution du radiotraceur, du
processus de rétroprojection filtrée et d’autres techniques tomographiques.
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General introduction

Nuclear medicine imaging is the use of radioactive substances in medicine for diagnose, evalu-
ate or treat a variety of diseases. These include many types of cancers, heart disease, gastroin-
testinal, neurological disorders and other abnormalities. It is also used in the basic sciences,
such as biology, in drug discovery and in pre-clinical medicine. Nuclear imaging is an emission
imaging used in nuclear medicine for diagnostic purposes. In single photon emission computed
tomography or less commonly, (SPECT), the patient is administered with a radiotracer which
emits radiation in the form of gamma rays or X-rays, which are detected by a gamma camera.
The most common radiotracer is technetium, which emits gamma photons of energy 140 keV.
In clinical routine, the gamma cameras used are still based on the principle of gamma cameras
developed by H. Anger in the 1960s. These cameras consist of one or more detection heads, and
each detection head is composed of a conventional collimation system and a scintillator-based
detection module. They make it possible to obtain the images, called scintigraphic images, in
planar acquisition or in tomographic acquisition [1].

SPECT imaging is performed by using a gamma camera to acquire multiple two dimen-
sional images, from multiple angles. Then, a tomographic reconstruction algorithm is applied
to the multiple projections, yielding a three dimensional data set. Precise measurement of
radioactivity contained in reconstructed images, called quantification, is affected by many phe-
nomena during the formation of images that alter the information extracted from these images.
Nuclear imaging provides non-invasive access to information about the functioning of organs
and to study physiological and metabolic processes. The reliability of the quantification of
the images obtained is affected both by the limits of the performance of the collimators and
detectors (spatial and energy resolution, sensitivity, septal penetration ...), by physical effects
such as diffusion and attenuation, which disturb the reconstruction of images, by physiological
effects (movements of the patient) and effects related to tomographic reconstruction. These
effects must therefore be corrected by specific correction methods in order to extract reliable
quantitative parameters. The most commonly used in clinical routine collimator is a paral-
lel hole collimator. Its dimensioning is optimized to ensure the best compromise between the
spatial resolution and the efficiency of the camera. However, this compromise may limit the
quality of the scintigraphic images, thus making the diagnostic interpretation of the images
difficult. The Monte-Carlo simulations are a widely and effective tool for different areas of
diagnostic nuclear imaging, such as, the optimization of detector components (collimator, scin-
tillator, photomultiplier ...), the design of new detectors . The method is useful for solving
complex problems when experimental measurements may be impracticable [2]. The design of
SPECT and PET (Positron emission tomography) imaging systems using the Monte Carlo tech-
nique has received considerable attention, and a large number of applications were the result of
such investigations. Another promising application of Monte Carlo calculations is the devel-
opment and evaluation of reconstruction algorithms and correction technique for attenuation
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General introduction

and scattered photons which degrade contrast, spatial resolution, and quantification, since with
Monte Carlo Simulation, it is possible to track and record the life history of the individual pho-
ton originating from the source that ultimately deposits its complete energy inside the crystal.
Therefore, unscattered and scattered photons can be tracked separately. Monte Carlo simula-
tion thus allows a detailed evaluation of the energy and spatial distribution of scattered photon,
which would be difficult to perform using experimental study . Many simulators are currently
available, but none of them has yet become a standard in nuclear imaging because each has its
own specificities and also its own shortcomings. In this work we use the SIMIND Monte Carlo
code , which is well established for SPECT with low-energy photons. Because of the interest in
simulating higher energy photon emitters, this code was recently combined with the collimator
routine that accounts for scatter and penetration. The SIMIND code is designed such that the
parameters to be calculated in a particular simulation can be easily changed. This is achieved
through a user-written scoring subroutine that is linked to the code. A call to the routine is made
at different stages during a photons history. Several scoring routines were used to generate the
images and spectra that were specific to this work. In, SPECT imaging, the quantification is
difficult for common nuclear medicine isotopes because of the higher energy of the photopeak
and the multiple γ-ray emissions [3]. Therefore, the inclusion of scattered photons in SPECT
images degrades spatial resolution, and contrast . In the case of higher energy photon emit-
ters such as I-131, both septal penetration and scatter in the collimator are significant [4]. The
SIMIND Monte Carlo code [5] used in this work includes complete modeling of collimator in-
teractions, which is essential when higher energy photon emitters are simulated . Our objective
in this thesis work was to evaluate and determine the optimal imaging parameters in SPECT
imaging by the means of Monte Carlo simulation [6, 12]. Chapter I recalls the general principle
of gamma imaging, describing the radiotracers, the detection chain, and the types of acquisition
of gamma camera. The limits of the SPECT, resulting mainly from technological and physical
factors, are finally addressed: the major phenomena disrupting the formation of images such
as attenuation and diffusion are described. Also this chapter presents the electromagnetic ra-
diation, spectrometry of electromagnetic radiation and SPECT correction methods developed
to correct image-degrading phenomena and prevent precise and reliable quantification of re-
constructed sections. Chapter II is devoted to the problem of tomographic reconstruction and
describes the main reconstruction algorithms used in SPECT. Chapter III recalls the principles
roles of Monte Carlo simulation in nuclear medicine imaging and then describes the SIMIND
Monte Carlo program and the different steps to follow to perform a simulation are exposed.
Chapter IV we evaluate the penetrated and the scattered photon fractions in the photopeak en-
ergy window for I-131 using Monte Carlo Simulation code. Chapter V this chapter proposes
to evaluate the scatter distribution for Lu-177 in order to determine the optimal situation for
image quality.
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Chapter 1

Single Photon Emission Computed
Tomography

Single-photon emission computed tomography (SPECT Scan) is a nuclear medicine tomo-
graphic imaging technique using gamma rays. It is very similar to conventional nuclear medicine
planar imaging using a gamma camera. However, it can provide 3-D information in the form
of cross-sectional slice images of the patient for example brain imaging. Computer imaging
systems can transform this information to produce the required image. The technique overall
requires delivery of a gamma-emitting radionuclide into the patient, normally through injec-
tion into the bloodstream. Since the development of computed tomography in the 1970s, the
radioisotope in the organ and/or tissue can be mapped by SPECT imaging. All gamma radia-
tion emitted from SPECT radiopharmaceuticals are detected by the usage of a rotating gamma
camera around the patient to produce 3-D imaging. The images undergo various electronic
transformations by taking into account the distribution of the radiotracer, the process of filtered
back projection and other tomographic techniques.

The radioisotopes used in SPECT scanning have relatively long half-lives, for example,
technetium-99m (t1/2= 6 hours), indium-111 (t1/2 days), iodine-123 (t1/2= 13.22 hours) and
thallium-201 (t1/2 = 73 hours). The radionuclide technetium-99m prepared from molybdenum-
99 by using the technetium-99m generator and used for a variety of nuclear medicine diagnostic
procedures. These technetium-99m based imaging agents are relatively cheap compared to PET
and MRI imaging. The problem with SPECT scanning is the absence of good spatial resolution.

1.1 Radiotracers
The Radiotracers, or radiopharmaceuticals, are radioisotopes bound to vector molecules able to
target specific organs, tissues or cells within the human body. These radioactive drugs can be
used for the diagnosis and for the therapy of diseases. The vector molecule is localized on the
structures that interest us. Radioisotopes are atoms whose nucleus is unstable and therefore ra-
dioactive. It chosen according to its chemical properties: its addition on a vector molecule must
not modify the properties of this molecule and the link between marker and carrier molecule
must be strong to prevent the marker from becoming detached. It may also comprise only
the radioisotope itself if it shows suitable biological properties. The radioactive isotope is
also selected according to the following physical characteristics: - the nature of its radiation:
gamma-emitting radioisotopes are favored because they lend themselves to external detection

16



Chapter 1. Single Photon Emission Computed Tomography

and minimize the radiation dose to the patient. These gamma rays must have enough energy to
get out of the body and low enough to allow effective detection by the detector. -the physical
half-life of the isotope must be long enough to allow the physiological process to be followed,
and sufficiently short for avoid unnecessary irradiation; Radiopharmaceuticals are used to pro-
duce images of organs of interest, a process that is called scintigraphy. A type of medical
device known as gamma camera is able to detect the gamma rays or x-rays emitted by the ra-
dioisotope. They are used for flow visualisation through different technologies, such as Single
Photon Emission Computed Tomography (SPECT), Positon Emission Tomography (PET). The
most widely used radioisotope in diagnostic nuclear medicine is technetium-99m. Since it has
almost ideal physical characteristics (half-life of 6 hours, average gamma energy of 14.5keV
(very good for crossing tissues and very good for easy detection), abundance of photons gamma
(98%) make it possible to minimize the dose delivered to the patient. Tc-99m can be attached
to several specific molecules, allowing the diagnosis of many diseases, including certain types
of cancers. Tc-99m-MDP (methylene diphosphonate) is widely used to detect bone metastasis
associated with cancer [13]. Tc-99m is produced from the decay of its radioactive precursor,
molybdenum 99 (Mo-99) and can be delivered on demand from a portable generator, mak-
ing it very easy to access clinically and inexpensively. These advantages have made Tc-99m
the most commonly used radionuclide for SPECT imaging. Other radioisotopes are also fre-
quently used, among which I-123(Iodine), I-131(Iodine), In-111 (Indium), Ga-67(Gallium),
Tl-201 (Thallium), Sm-153 (Samarium), Lu-177 and Lu-177(Lutetium). The physical char-
acteristics of these radioisotopes, as well as their mode of production, are recalled in Table
1.

Isotopes
Gamma
emission

energy(keV)

Physical
period Production mode Application

Tc-99m 140,5(90%) 6.02h IT

I-123 159 13h PBR : Te-124(p,2n) → I-123
: I- 127(p,5n) Xe-123 → I-123

The metabolism of
the thyroid

I-131 364 8.05d NF -

In-111 171, 245 67.9h PBR: Cd-112(p,2n) →In-111

Imaging the produc-
tion, migration and
reabsorption of cere-
brospinal fluid.

Ga-67 93, 184, 300 78.3h PBR: Zn-68(p,2n) →Ga-67 Image the function
of the bone marrow

Tl-201 63, 80.3 73h PBR: Tl-203 (p,3n)Pb-201→Tl-201 Evaluate myocardial
blood perfusion

Sm-153 103 46.7h NC: Sm-152+n→ Sm-153 + γ
Treatment of bone

metastases

Lu-177 113 (6.4%)
208 (11.0%) 6.647 d NBR: Lu-176(n,γ) → Lu-177

Treatment of
neuroendocrine

tumors and prostate
cancer

Table 1.1: Properties and production of the main isotopes used in SPECT.

The radioisotope is often administered intravenously, sometimes by inhalation to study pul-
monary ventilation. It can be administered in a suitable chemical form (eg 131I administered
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in the form of 131 I a sodium iodide) or in combination with a molecule: many molecules can
be labeled, including the substrates of a metabolic pathway, antibodies, hormones , peptides,
drugs, groups of molecules.

1.2 Gamma camera
The gamma camera (Figure 1.1) [14], also called a scintillation camera or Anger camera, was
invented by the American physicist Hal Oscar Anger in 1957. Then, it widely imposed and has
been marketed and used in clinical routine from the 60s. The camera gamma itself does not
emit any radiation, but it detects radioactive energy that is emitted from a radiotracer distributed
in the body and converts it into an image, a technique known as scintigraphy. The role of
the scintigraphy is to visualize and analyze images of the human body or the distribution of
injected, inhaled or ingested medical radionuclide, emitting gamma- or x-rays. The camera
consists of a lead collimator that allows photons traveling in given directions to pass through
a large diameter scintillator (commonly NaI(Tl) scintillation crystal) that converts the energy
of γ-ray or x-rays photons to burst of light which is in turn converted to electric signals by
detectors (photomultiplier tubes) located behind the crystal. Electrical output from detectors
is fed to computer to produce information about the position at which a photon interacts with
the crystal. The gamma camera produces a 2D image of the 3D representation of activity
distribution within the patient’s body. The modern gamma camera is under computer, allowing
the physician to select the study the number of counts to be acquired, control the detector and
patient bed positions and whole body procedures, and visualize the image. A gamma camera
consists of one or more detection heads, which are encased in metal and plastic, an analog
circuit providing the location of the gamma photons in the crystal and performing spectrometry,
and processors ensuring the acquisition of data, storage and their treatment: online corrections,
reconstruction, manipulation and display of images. The detection head is protected by a lead
shielding of sufficient thickness to minimize the background noise introduced by the radioactive
sources outside the field of view of the camera. The patient lies on the examination table which
slides in between two parallel gamma camera heads that are positioned above the patient. The
individual elements of the gamma camera will now be considered in more detail.

A gamma camera consists of one or more detection heads, which are encased in metal
and plastic, an analog circuit providing the location of the gamma photons in the crystal and
performing spectrometry, and processors ensuring the acquisition of data, storage and their
treatment: online corrections, reconstruction, manipulation and display of images. The detec-
tion head is protected by a lead shielding of sufficient thickness to minimize the background
noise introduced by the radioactive sources outside the field of view of the camera. The patient
lies on the examination table which slides in between two parallel gamma camera heads that
are positioned above the patient. The individual elements of the gamma camera will now be
considered in more detail.

1.2.1 Collimator
A collimator is a thick plate made of a material with a high atomic number (lead, tungsten,
etc.) that is highly absorbent for photons and has cylindrical or conical holes, with a circular or
hexagonal section, in a system of axes determined. Only photons whose path does follow these
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Figure 1.1: Siemens Symbia T2 SPECT CT gamma camera

directions will pass into the crystal. Therefore, the collimator determines the direction of the
projection. Thus an image is formed by excluding all gamma rays except the small number trav-
eling in the preferred direction perpendicular to the detector. The scintigraphic image obtained
after the collimator corresponds to the projection of the distribution of the radioactivity on the
detector crystal. The thickness separating two adjacent holes is called septum (plural septa).
The lead thickness is calculated to result in attenuation of at least 95% of the photons crossing
the septa. There are four basic collimator types namely parallel hole, pinhole, diverging and
converging. The most common type, the parallel hole collimator, is shown in Figure. It consists
of a lead plate through which runs an array of small holes whose axes are perpendicular to the
face of the collimator and parallel to each other. This kind of collimator keeps the same size as
the source distribution onto the detector. The geometrical parameters (length and diameter of
the holes, thickness of the septa, etc.) of a collimator with parallel holes vary according to the
energy of the isotope used and the examinations to be carried out. Other collimators are also
used in specific cases: this is the case of the pinhole collimator, consisting of a single aperture
of 3 to 5 mm in diameter located at the end of a conical lead shield for imaging organs small
and superficial (thyroid gland, joints, ...), or divergent / converging collimators for whole body
imaging or imaging of organs of average size.

The gamma camera can detect four kinds of events which are: - True event: a photon is
emitted parallel to the collimator holes, passes through a hole and interacts with the crystal,
depositing all of its energy at a single location. - Detector scatter event: a photon is emitted
parallel to the collimator holes, passes through a hole and interacts by Compton scattering with
the crystal, depositing only part of its energy. - Object scatter event: a photon is not emitted
toward the collimator holes but scattered by the patient body and passes through a collimator
hole and subsequently is detected. - Septal penetration: in this case a γ ray is emitted toward
the collimator, but not in parallel to it. Causing blurring of the image. The main parameters
describing collimator performance are spatial resolution and sensitivity. Parallel geometry is
the simplest from the point of view of reconstruction. The collimator defines the geometric
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Figure 1.2: Different elements composing a gamma-camera detection head

field of view of the gamma camera and it is this which substantially determines the spatial
resolution and sensitivity of the detection system.

1.2.2 The scintillating crystal
After the photons have travelled through the collimator, they interact with the cameras scintil-
lation crystals which represent the detector part from the camera. The crystal convert energy
deposited by energetic particles (charged, gamma or X photons) into light scintillation. The
scintillator must have high stopping power for photons, hence the choice of dense crystals with
a high atomic number, which improves the efficiency of the detector. Indeed, when a photon
interacts in the scintillating crystal by a Compton effect or a photoelectric effect, it gives him
a part or all its energy respectively. Most SPECT systems are equipped with sodium iodide
crystal doped with thallium NaI(Tl). Its effectiveness at stopping the photons depends not only
on its density but also on the thickness of crystal used. The choice of crystal thickness is a
compromise between the detection efficiency and the spatial resolution which degrades when
the crystal becomes thicker. The thickness of the NaI (Tl) is typically between 6 and 10 mm for
the SPECT systems and can reach up to 25.4 mm in order to be able to stop the higher energy
photons. Its effectiveness at stopping the gammas depends not only on its density but also on
the thickness of crystal used Thallium-doped Sodium Iodide produces one of the highest signals
in a PMT per amount of radiation absorbed. Under optimum conditions, an average of 10000
photoelectrons is produced per MeV gamma rays. Scintillation crystals convert the gamma rays
or x-rays to visible light, which is then directed through a light guide to a photomultiplier tube.
A scintillating crystal must have high intrinsic efficiency, good intrinsic spatial resolution, and
good energy resolution. The spatial resolution and the energy resolution strongly depend on the
magnitude of the scintillation generated at each detected event. Scintillators have the advantage
of having a high intrinsic efficiency and a reasonable manufacturing cost. In addition, they are
available in many forms and sizes. The disadvantage of scintillating crystals lies in their need
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Figure 1.3: Different types of collimator and their corresponding geometries: (a) parallel hole collimator, (b)
fan-beam collimator, (c) pin-hole collimator.

for a photon light converter into an electrical pulse.
Only a small fraction of the energy lost by a photons ray is converted into light, typically

10%, producing about 3000 light photons at a wavelength of 410 nm for each 100 keV of
gamma ray energy absorbed, this wavelength, matches quite closely that required by the PMT.
This causes information loss (light photons) at the interface between the crystal and the con-
verter (PMT), which limit the energy resolution of the detector. The length of each scintillation
must be short to avoid the overlap of light from consecutive scintillations. NaI(Tl) suffers from
the drawbacks of being expensive to produce as a large crystal, fragile and so needing protection
from both thermal and mechanical stresses, and hygroscopic, requiring to be canned to prevent
contact with moisture. The intrinsic spatial resolution and mean energy resolution as well as the
hygroscopic nature of NaI (Tl) prompted researchers to develop other inorganic scintillators.
Unfortunately, only a small fraction of the energy lost by a gamma ray is converted into light,
typically 10%, producing about 3000 light photons at a wavelength of 410 nm for each 100 keV
of gamma ray energy absorbed. This wavelength, however, matches quite closely that required
by the PMT. The length of each scintillation must be sufficiently short to avoid the overlap of
light from consecutive scintillations. In the NaI(Tl) crystal it takes about 0.8µ s to collect most
of the light, and this will obviously affect the maximum gamma ray rate that the camera can
handle without producing a distorted image . NaI(Tl) also suffers from the drawbacks of being
expensive to produce as a large crystal, fragile and so needing protection from both thermal and
mechanical stresses, and hygroscopic, requiring to be canned to prevent contact with moisture.
The latter requirement poses a problem since it is also necessary to ensure that the light emitted
in the scintillation is transmitted to the second part of the detector system, the PMT array. While
the front face and sides of the crystal are canned, usually with aluminum sufficiently thin so as
not to attenuate the incoming gamma rays unduly, the rear crystal surface needs a transparent
interface between the crystal and PMTs. This is usually provided by a Pyrex optical plate or
light guide a few centimeters in thickness. Despite the obvious problems with using NaI(Tl),
it has proved to be the only satisfactory scintillation material for gamma cameras. While it is
possible, at least in theory, to produce an image from the scintillation in the crystal, the main
advantage of first converting this image to electrical signals is that pulse height analysis can be
used to reduce the effect of scattered photons on image quality.
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The light yield yield of NaI(Tl) is (39±1)103 photons per MeV. Because there is an overlap
in both sensitive frequency regions this setup has a high scintillation conversion efficiency. The
electric field between the cathode and the first dynode accelerates the electron to create a small
electron avalanche. CsI (Tl) is for example less hygroscopic than NaI (Tl), but also less efficient
with PMTs, even if the number of scintillations is 18% higher than that of NaI (Tl). On the other
hand, the detection of the light photons generated by the CsI (Tl) is more efficient by replacing
the PMTs by photodiodes. CsI (Na) has the same characteristics as CsI (T1) with scintillation
better adapted to PMTs. LaBr3 has attracted PET attention as a potential scintillator, but its
properties are also attractive for SPECT. Its light response is very fast and its energy resolution
(<6% at 140 keV) is much better than that of NaI (Tl) ( 10% at 140 keV). Recently, LaBr3 has
also been used as a detector in small animal SPECT systems. Table 1 shows three clinically
used scintillating crystals and their main properties. Having effective atomic numbers and
comparable densities, these four crystals will have almost similar efficiency values. It has a
good luminous efficiency: 13% of the energy deposited is reemitted in the form of fluorescence
photons of energy 3 eV (430 nm). It is transparent to its own scintillation light, which prevents
scintillation losses by self-absorption. Its time constant of 230 ns allows it to record several
tens of thousands of hits per second, thus allowing a high counting rate. Its main disadvantage
is its hygroscopic (moisture sensitive) character and therefore requires hermetic isolation (e.g.,
Al2O3 layer, epoxy, etc.).

Desirable properties of the scintillation crystal - High efficiency for stopping gamma rays
- Stopping should be without scatter
- High conversion of gamma ray energy into light
- Wavelength of light should match response of the PMTs
- Crystal should be transparent to emitted light
- Crystal should be mechanically robust
- Length of scintillation should be short

Scintillator
Effective
atomic

number Z

Density
(g/cm3)

decay time
(ns)

Wave length
(nm)

NaI(Tl) 50 3.67 200 415
CsI(Tl) 54 4.5 1000 550
Cs(Na) 54 4.51 630 420

LaBr3:Ce 47 5.3 25 360

Table 1.2: Properties of the main scintillators used in SPECT

1.2.3 The light guide
The role of the light guide is to direct the light to each PMT to increase the efficiency of the
light collection and imaging. It is made of a material with a refractive index close to that of the
scintillating crystal, so as to optimize the transport of light towards PMs. The shape of the light
guide is carefully adapted to that of the photocathode of the PM. The light guide also helps
to reduce PM light collection efficiency variations: the light loss caused by dead spaces that
do not cover the entry face of the PM is reduced by the light guide, which collects the light
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emitted in these dead spaces and directs it to the photocathode of the PM. In gamma cameras,
the light guide has significantly contributed to improving the linearity of the detection response,
to the detriment of the intrinsic spatial resolution. Currently, the available PMs provide optimal
coverage of the crystal surface (thus reducing dead space) and the light guide is being replaced
more and more by automatic uniformity correction methods.

1.2.4 Photomultiplier tubes (PMTs)
Scintillations produced in the crystal are detected by a large number of PM tubes which are
arranged in a two-dimensional array. The number of PMs placed on the surface of the crystal
can vary between 37 and 91 PMTs in modern gamma cameras. The PMTs are usually arranged
in a close packed array to ensure that the smallest possible gaps are left between tubes. PMTs
typically have a circular section with a diameter of 5 cm and are placed in a pattern hexagonal.

Figure 1.4: Schematic of a photomultiplier tube coupled to a scintillator.

The role of PMs is to convert visible light from scintillation into the crystal into an electrical
signal that can be used by electrical circuits. PM is a vacuum tube with a photocathode and
anode, between which are dynodes, which are intermediate potential electrodes. When a light
photon reaches the photocathode, a photoelectric effect will take place and an electron will
be ejected from it. With electrodes set to a certain potential, field lines are created, and the
electrons coming out of the photocathode will follow these field lines to finish on the first
dynode. They arrive there with a kinetic energy which allows them to tear out secondary
electrons. These electrons are in turn accelerated to the next dynode by increasing potential
difference and will in turn tear off other electrons. The process continues until the last dynode.
The electrons will eventually be collected at the anode and give a measurable electrical signal
at the output. The PMT not only converts light into an electronic signal but also, magnifies
the electronic signal to give a sufficiently large current for the subsequent electronics. PMTs
Conversion efficiency is a function of the wavelength of Incident light. The PM amplification
factor can be up to 106. Even with this signal amplification pre-amplifiers built into the PMTs
are necessary to ensure a sufficient signal-to-noise ratio. The PMTs produce a signal that is
proportional to the light generated in the crystal. The PMTs will direct the signal to the system
electronics. The signal is transferred electronically to a position circuit. The more modern
gamma cameras operate through an Analog-to-Digital Converter system. This means that the
PMTs output is directly digitalized through the system. These systems are able to extract the
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position and energy data simultaneously. Positional information can be obtained by comparing
the size of the signals from different PMTs, whereas the energy information is related to the
sum of the PMTs signals. The final step to the image acquisition process comes once the images
are generated on a computer monitor where they can be constructed and altered.

1.2.5 Positioning Circuit
The analog electronic circuit makes it possible to determine the location of the point of interac-
tion of the photon in the crystal and the value of the energy of the photon. For this, the circuit
analog consists of a network of four resistors by PMT. The study of the electrical signals at the
terminals of each resistance of all PMTs makes it possible to calculate by barycentric weighting
the location of the interaction point and the energy of the photon.

The signals of the resistors provide positioning along the X ( X+ and X− ) axis and the
positioning along the Y ( Y + and Y − ) axis, but also the energy of the E photon (corresponding
to the sum of the signals of all PMTs). The total sum of the voltages (marked σ in the figure)
from each photomultiplier, measured by a pulse height analyzer (PHA) is proportional to the
energy of the gamma ray interaction, thus allowing discrimination between different isotopes
or between scattered and direct photons.

The total sum of the voltages (marked σ in the figure) from each photomultiplier, measured
by a pulse height analyzer (PHA) is proportional to the energy of the gamma ray interaction,
thus allowing discrimination between different isotopes or between scattered and direct pho-
tons.

The amount of energy deposited by the photon during its interaction in the crystal is pro-
portional to the amount of light emitted during the interaction, equal to the sum of the signals
Z of all the PM

Z = X+ + X− + Y + + Y − (1.1)

The interaction point (X, Y) will be given by:

X = X+ + X− (1.2)

Y = Y + + Y − (1.3)

In order for the X and Y interaction coordinates to be independent of the emission energy
of the radioisotope used, the raw values of the X and Y coordinates are normalized to the total
energy of the event being processed.

X =
X+ + X−

X+ − X− (1.4)

Y =
Y + + Y −

Y + − Y − (1.5)

Thus, during an acquisition, all the interactions are listed according to their position X (±∆
X). ) and Y (±∆ Y) and their energy E (±∆ E). The scintigraphic image then corresponds to
the visualization of the number of interactions in each position and whose energy is included
in a window in energy, for example between two energies: E0 - ∆E0 and E0 + ∆E0,
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where E0 is energy of the photon radioisotope study (typically, 140 keV of 99mTc) and
∆E0 is the half-height width of the energy response for E0 energy

Figure 1.5: Position circuit

This voltage pulse is commonly called the Z-pulse which, following pulse height analysis,
(PHA) is fed as the unblank pulse to the CRO. So we end up with four position signals and
an unblank pulse sent to the CRO. The core of a CRO consists of an evacuated tube with
an electron gun at one end and a phosphor-coated screen at the other end. The electron gun
generates an electron beam which is directed at the screen and the screen emits light at those
points struck by the electron beam. The position of the electron beam can be controlled by
vertical and horizontal deflection plates and with the appropriate voltages fed to these plates
the electron beam can be positioned at any point on the screen. The normal mode of operation
of an oscilloscope is for the electron beam to remain switched on. In the case of the gamma
camera the electron beam of the CRO is normally switched off - it is said to be blanked. When
an unblank pulse is generated by the PHA circuit the electron beam of the CRO is switched on
for a brief period of time so as to display a flash of light on the screen. In other words the voltage
pulse from the PHA circuit is used to unblank the electron beam of the CRO. So where does this
flash of light occur on the screen of the CRO? The position of the flash of light is dictated by the
±X and ±Y signals generated by the position circuit. These signals as you might have guessed
are fed to the deflection plates of the CRO so as to cause the unblanked electron beam to strike
the screen at a point related to where the scintillation was originally produced in the NaI(Tl)
crystal. The gamma camera can therefore be considered to be a sophisticated arrangement
of electronic circuits used to translate the position of a flash of light in a scintillation crystal
to a flash of light at a related point on the screen of an oscilloscope. In addition the use of
a pulse height analyser in the circuitry allows us to translate the scintillations related only to
photoelectric events in the crystal by rejecting all voltage pulses except those occurring within
the photopeak of the gamma-ray energy spectrum.

25



Chapter 1. Single Photon Emission Computed Tomography

1.3 Performance of a gamma-camera
The performances of a gamma camera are characterized by several parameters: spatial resolu-
tion, energy resolution, sensitivity, uniformity and linearity. Each of these parameters depends
on the characteristics of the different components of the detection head and is very often cor-
related. An inherent trade-off in the design of SPECT collimators are resolution vs sensitivity.
It is possible to improve the spatial resolution of a collimator by further restricting the range of
incident angles, but this is at the expense of reducing sensitivity. Anger cameras require colli-
mators to localize the site within the patient from which the gamma ray photons are emitted.
Because of this resolution vs sensitivity trade-off, the collimator is perhaps the most significant
component of the SPECT camera affecting image quality.

- Parallel-hole collimators In single photon emission computed tomography (SPECT),
the type of collimator to use for a given imaging application depends mainly on the size of the
FOV, the size of the detector and the required spatial resolution and/or sensitivity

Figure 1.6: Parameters of a parallel collimator

1.3.1 Spatial resolution
Spatial resolution quantifies the size of the smallest object that can be resolved reliably, and is
is measured by the FWHM (Full Width at Half Maximum) of the point spread function (PSF)
or linear, obtained by making the image of a point source or linear source respectively.

The total resolution R of the gamma-camera is the result of the contribution of the intrinsic
spatial resolution RI and the spatial resolution of the collimator RC to the collimator-source
distance: The intrinsic spatial resolution Ri is typically 3.5-4.0 mm for Tc-99m and is related
to the characteristics of the crystal and the position logic circuitry used to compute the location
of the detected photon. The spatial resolution is affected by the collimator. For a high resolu-
tion, the spatial resolution is approximately 10 mm for a Tc-99m point source located at 10 cm
from the collimator face. The resolution varies for different collimators depending the on the
geometry of the collimator. Collimators with smaller and longer holes will have better spatial
resolution but will have lower sensitivity. A parallel-hole collimator with hexagonal holes and
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Figure 1.7: Measurement of the spatial resolution of a gamma camera, given by the width at half maximum of
the point spread function.

a perfectly absorbing detector has a point-source and a geometric spatial resolution [15]:

Rph = d
a+ h

ae
(1.6)

Where d is the hole diameter (at-to-at distance), and h is the perpendicular distance from
the point source to the detector. ae = − 2

µ
is the physical hole length a (collimator thickness)

approximately adjusted for penetration effects. µ is the attenuation coefficient 1
µ
= 0.37mm

for Tc99m and lead. The collimator resolution expression do not include the mean interaction
depth in the detector, which is generally much smaller than the distance from the source to
the collimator surface and the collimator thickness. Spatial resolution is an important system
property and is commonly quantified from the full-width-at-half-maximum (FWHM) of the
point spread function (PSF), which is determined by the detector intrinsic resolution and the
geometrical resolution of the collimator. The system resolution is:

R =
√

R2
i +R2

ph (1.7)

As shown in equation (1), the spatial resolution of the collimator increases as the source-
collimator distance increases. This same equation shows that, we can improve the spatial reso-
lution by increasing the length of the holes and the number of holes per unit area, or minimizing
the distance between the source and the surface of the collimator. However, improving the spa-
tial resolution by modifying the geometric parameters of the collimator leads to degrade the
sensitivity of the gamma-camera. The choice of the collimator will therefore be based on the
energy of the radioisotope used and considering an acceptable compromise between spatial
resolution and sensitivity.

1.3.2 The count rate
When the count rate is very high, two events too close together can give rise to only one pulse
at the level of the electronic detection circuit. The apparent energy can then exceed the limits
imposed by the spectrometric window, in which case the pulse is rejected. Other phenomena
can also appear, such as the simultaneous detection of two Compton events whose sum of
deposited energies is sufficient for the detector to consider the two detected Compton events as
a single event belonging to the photopic window. In SPECT, a compromise is usually sought
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by administering an activity such that the counting rate does not give rise to a loss of more than
20% on the detection of the activity. This potential loss would be related to the timeout.

1.3.3 Sensitivity
Another important system property is sensitivity, which is expressed by the ratio of the number
of photons per second detected and accepted through the energy window to the total number
of photons emitted by the radioactive source at the solid angle seen by the detector, i.e. in
cps/MBq. This value depends mainly on on the type of collimator, the radionuclide used, the
light output of the crystal and width and position of the energy window. The sensitivity depends
mainly on the type of collimator used and the light output of the crystal [16]. It is given by

Sph =

√
3

8πa2e(d+ t)2
d4 (1.8)

The equation shows that the sensitivity for a parallel hole collimator is independent of the
distance between the source and the surface of the collimator. While, resolution depends on
the distance h. The sensitivity of a gamma-camera with parallel holes is typically of the order
of 0.01% [Madsen, 2007]. This value can be increased, without degradation of the spatial
resolution, by using several detection heads. In single photon emission computed tomography
(SPECT), every study on collimator utilizations show that resolution may be advantageous to
small lesion oncology SPECT imaging, while high-sensitivity is generally considered to be
more important than resolution in the cardiac SPECT imaging

1.3.4 Energy resolution
Image quality is affected by energy resolution which reflects the accuracy with which the
gamma camera is able to determine the energy of a detected photon. Ideally, images would
be comprised of only primary photons emitted by the decay of a radionuclide, not the scattered
photons. The better the energy resolution result of the discrimination of primary from scattered
photons, and thus, the better the image contrast, resolution and the more accurate activity quan-
tification and distribution of the radionuclide in organ. For most modem Anger cameras, the
energy resolution is expected to be 9-10% for the 140-keV photons from Tc-99m, and 15-17%
for the 72-keV photons from Tl-201[]. The inaccurate measurement of energy comes from
statistical fluctuations in the number of optical photons emitted by scintillation, quantum yield
in photo-cathodes, gain in photomultiplier tubes, and acquisition electronics. The energy reso-
lution is determined by the half width at half maximum FWHM (E) of the energy response of
the gamma-camera for the emission energy E of the radioisotope used and is expressed in%:

FWHM(E) =
∆E

E
× 100 (1.9)

The scatter photons at a low angle retain much of their initial energy. Thus, this photons can
be detected in the conventional acquisition window, which is centered on the emission energy
of the radionuclide having a width of 20% thereof. For example, a 140 keV photon, emitted
by 99mTc, loses only 14 keV of its energy when it undergoes a Compton scattering effect at
52deg and will therefore be counted in the photopic window (140 14 keV) as a photon primary.
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At 140 keV, emission energy of 99mTc, the energy resolution is typically 10% for current
cameras. A standard energy window of 20% centered around the 140 keV energy peak of the
emitted photons is used for Tc-99m. The greater width and smallest energy and the Tl-201
photo-peak require a wider energy window. An energy window setting of 30% is appropriate
for the 70 keV peak of Tl-201, and a 15% energy window is appropriate for the 167-keV peak.

1.3.5 Spatial linearity
The spatial linearity which characterizes the geometric distortions or localization defects ob-
served between the measured position of the photons and their real position in the input plane
of the detector. It can be measured by analyzing the geometric distortions induced in the re-
production of an image of linear sources. Poor linearity introduces image deformation and
troublesome field homogeneity in tomographic mode. These linearity defects depend strongly
on the homogeneity of photocathode response of the photomultiplier tubes, the number of tubes
used, the homogeneity of the crystal and the light guide when is present [17]. Spatial distor-
tions were minimized by increasing the number of photomultiplier tubes equipping the gamma
cameras and selecting tubes with more homogeneous photocathodes.

1.3.6 Uniformity
The uniformity that characterizes the ability of the system to reproduce a homogeneous image
when the detector is subjected to uniform irradiation of the field of view. Uniformity can cause
very important artifacts in tomography: small localized variations in uniformity, of the order of
5%, can lead to circular artifacts on the images.

1.3.7 Processors
Processors provide data acquisition, display and storage of images. They also allow for online
corrections and data processing. Online corrections are intended to reduce imperfections in
the gamma camera. They include automatic PMT gain adjustment (verification of calibration
and stability in time and space), energy correction, linearity correction (suppression of spatial
distortions by correction of X and Y coordinates in real time) and correction of efficiency
(standardization by correction of the values of each image pixel). Data processing consists of
processing the information in order to obtain an exploitable image. It includes for example the
techniques of smoothing or filtering images, and image reconstruction techniques.

1.3.8 Modes and types of acquisition of an Anger gamma camera
Anger’s gamma camera can operate in two modes: a static mode and a dynamic mode.
The static mode is a mode where time information is not exploited. The information used is
that recorded during the total duration of the acquisition.
The dynamic mode is a mode where time information is exploited. The information used is
time-related, ie the acquired data are processed according to "activity-time" curves. This dy-
namic mode makes it possible to know the functioning of organs such as the kidneys (dynamic
renal imaging) or the heart (dynamic cardiac imaging). For this last example, the "activity-time"
curves can be obtained by a synchronization between an electrocardiogram and the gamma
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camera in order to position the images in the cardiac cycle. These two modes (static and
dynamic) are used as well in planar acquisition (acquisition at a single angle of view) in tomo-
graphic acquisition (acquisition in several angles of view).
- During a planar acquisition, the detection head of the gamma camera remains fixed throughout
the acquisition. This acquisition makes it possible to explore only part of the body correspond-
ing to the field of view of the gamma camera. This type of acquisition allows the doctor to have
a 2D image directly interpretable, corresponding to a 2D projection of a 3D volume (the pa-
tient). No information on the deep location of the radioactive sources distributed in the patient
is then available.
- During a tomographic acquisition, the detection head of the gamma camera rotates around the
patient. The detection head then makes acquisitions at different values of discrete viewing an-
gles. Typically, a tomographic acquisition has 64 or 128 viewing angles covering 360◦ around
the patient. This type of acquisition requires image reconstruction techniques so that the doctor
has interpretable images in the form of (2D) sections of a volume (3D). The deep location of the
sources distributed radioactive material in the patient is then known. Tomographic acquisition
is commonly called SPECT, for Single Photon Emission Computed Tomography in English.

1.3.9 Examples of scintigraphic examinations
Different medical specialties make use of scintigraphic examinations, in order to highlight
certain pathologies. For example, - scintigraphy is used in cardiology (heart study). It then
makes it possible to study the functioning of this muscle (its way of contracting) and to highlight
possible ischemic areas during an effort or necrotic areas (in the case of infarction).
- Scintigraphy is used in neurology (study of the brain) [18]. It allows for example the study of
certain degenerative diseases (such as Alzheimer’s disease), epileptic, or infectious.
- Scintigraphy is used in endocrinology. It allows the study of the thyroid and parathyroid.
For example, it is required if one suspects a hyperthyroid, possibly even a hypofunction or an
increase in volume of the thyroid (goiter) or for the control of a surgical operation.
- scintigraphy is used in oncology. It allows, for example, to detect tumors or metastases in the
bones (Figure I-5), or to identify sentinel lymph nodes during breast cancer.

1.4 The limitations of SPECT imaging
Many factors affect the qualitative and quantitative accuracy of SPECT images, including phys-
ical factors (related to the interaction properties of photons with matter), technological factors
(related to the components of Anger’s gamma cameras) and physiological factors (related to
the distribution of radiotracers in the patient and to the morphology of the patient).

1.4.1 Physical factors
Physical boundaries are related to photon interactions in the patient’s body. The two main inter-
actions of photons with matter are the photoelectric effect and Compton scattering. Following
these interactions, two phenomena affect the quantification of the activity in the area of interest:
the attenuation phenomenon and the phenomenon of photon scattering by the patient’s tissues
and the collimator crossed before reaching the detector.
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Figure 1.8: Raw arterial spin labeling (ASL) images of the represented subjects. (A) ASL perfusion images of
a 70 year-old subject that is eligible for image quality checkup and enrollment. (B) ASL perfusion images from
a 72 year-old subject that showed proximal portions of the arterial tree (arrows), indicating extremely prolonged
arterial transit time and not eligible for study enrollment.

The attenuation

The number of photons that "disappear" (either by photoelectric absorption or diffusion at a
sufficiently wide angle that they can not be detected) in the thickness dx is proportional to the
number of incident photons N and to the thickness dx of material traversed; after the crossing,
there remain N + dN photons:

dN = −µNdx (1.10)

The linear attenuation coefficient µ expresses the probability that a photon will interact with
matter. It depends on the material traversed and the energy hν photons; it has the dimensions
of the inverse of a length and is often expressed in cm−t .This law results from the integration
on a thickness x of the previous differential equation.

N = N0e
−µx (1.11)

It is identical if we reason in flux of photons: ϕ= ϕ0 e−µx, as well as in surface flux or
even in intensity (provided that the light is monochromatic). A half-attenuation layer N1/2 is
defined; it is such that the number of incident photons is divided by 2.

N1/2 =
ln2

µ
(1.12)

N1/2 depends on the absorbing medium (atomic number Z and state, gas, liquid, solid) and
the energy hν of the photons (but does not depend on the thickness already traversed by the
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beam). Note: after a path equal to n N1/2 , the number of photons is divided by 2n. Linear
attenuation coefficient and section effective interaction σare linked by the relation:

µ

ρ
=

NA

A
σ (1.13)

Where,
ρ: represents the density of the traversed medium(g/cm3),

NA: the number of Avogadro (in atom mol−1), A: the atomic mass of the medium (in g /
mol) and σ the total cross section (in cm2/atom).

The interactions responsible for attenuation are photoelectric effect, Compton scattering,
scattering, and pair creation. At energies typically less than the MeV involved in medical
imaging, the pair creation is not concerned since it requires a threshold energy of 1.022 MeV
to create the two photons of the pair. The linear attenuation coefficient is the sum of the three
partial coefficients corresponding to the three main types of interaction of radiation with matter.

µ

ρ
=

NA

A
(σphotoelictric + σrayleigh + σcompton + σpair) (1.14)

The photoelectric absorption

The photoelectric effect corresponds to the total absorption of the gamma photon by an atom
whose energy is transferred to an electron that will be ejected from one of the electronic layers
of the atom. This electron is called a photoelectron which carries a kinetic energy Ek equal to
the energy of the incident photon E = hν minus the binding energy of the electron Eb on the
electronic layer that it occupies:

Ek = Eγ − Eb (1.15)

Eb is usually small compared to Eγ , so that the photoelectron carries off most of the photon
energy.

Figure 1.9: Photoelectric effect

As a result of the photoelectric effect, the vacancy in the electron shell will be filled even-
tually another electron from the external orbital, resulting into the emission of characteristic
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x-ray (fluorescence) photons or auger electrons (effet Auger). The photoelectric effect priority
being given to the more bound electrons, but it can occur with electrons of a layer i only if

Eγ > Ebi, where Ebi is the electron binding energy of the layer i. The photoelectric effect
is the predominant mode of interaction of low energy γ or X radiation ( ≤100 keV) .

. It is very favored for high Z materials and decreases when the energy increases. If the
photon has an energy greater than the energy of electron bonding of the K layer, it is essentially
with the electrons K (more than 80%) that the photoelectric effect occurs. The photoelectric
absorption breaks down into two sub-effects: the external photoelectric effect and the internal
photoelectric effect. The first is the interaction of photons with the electrons of the outer elec-
tron layers of an atom. For this phenomenon, the photons must have a minimum energy hv
called activation energy depending on the nature of the interaction medium. Indeed, it must be
at least equal to the energy required to break the covalent bonds of the material. If this condi-
tion is fulfilled, one or more electrons of the structure absorb the energy of the incident photon
thus creating the external photoelectric absorption phenomenon. When the incident energy is
larger, the external photoelectric effect gives way to the internal photoelectric effect. This is a
deeper interaction: the incident photon with significant energy interacts with the deep electron
layers of the atom.

-Fluorescence
Fluorescence is a radiative process of de-excitation of the ionized atom. When an electron fills
the vacant level from a higher energy bound state, a photon is emitted out of the atom with a
hv energy corresponding to the energy difference of the start and end states of the transition.
Electronic transitions coupled with the emission of a photon are subject to selection rules.

-Auger effect
An ion-excited atom, in the K-layer, for example, does not necessarily emit a K-series photon
out of the atom. Indeed, the emitted photon can be absorbed by the atom itself and be used
for the expulsion of a second electron from the upper layers (L, M,... in our example). This
phenomenon is called the Auger effect and constitutes a non-radiative transition or internal
conversion. For a given atom there is competition between the phenomenon of X fluorescence,
which gives rise to the emission of a photon out of the atom, and the Auger effect, which
gives rise to the emission of electrons out of the atom. It is obvious that, in a single atom,
the two phenomena cant take place simultaneously: the Auger effect will therefore limit the
fluorescence yield X.

The photoelectric cross section per atom σph photo is approximately:

σph ≃ Zn

E3,5
(1.16)

Where, E energy of incident photon and Zn is the atomic number of the atom. The cross
section depends strongly on the atomic number Z of the absorber medium and the energy of
the photon. The exponent varies from 4 and 5 depending of photon energy.

Compton scattering

The Compton effect consists in the transfer of a part of the energy of the photon to an electron,
usually to an electron of the outer layers of the atom at rest (considered as free since we can
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neglect its binding energy ). It follows the diffusion of a photon of energy E depending on the
diffusion angle:

Figure 1.10: Compton effect

Both the scattered photon and the electron are emitted from the atom. In Compton effect
the photons are generally more energetic than when the photoelectric effect occurs (X-rays or
gamma rays).

The conservation of the energy and the momentum during the interaction make it possible
to establish a relation between the incident photon energies Eγ

and the scattered photon as a function of the angle of scattering θ a thereof. In the follow-
ing calculations, the binding energy of the electron is neglected because the Compton effect
concerns the loosely bound electrons of the outer electron layers of the atom. The energy of
the scattered photon E ′

γ is given by:

E ′
γ =

Eγ

1 + hν(1−cos θ)
m0c2

(1.17)

Where, m0c
2 is the electron rest mass energy (= 511 keV).

Then, the energy of the recoil electron Ee is

Ee = Eγ − E ′
γ = Eγ

Eγ(1−cos θ)

m0c2

1 + Eγ(1−cos θ)

m0c2

(1.18)

The angle ϕ between the trajectory the electron Compton and the direction of the incident
photon is given by:

tanϕ =
E ′

γ sinϕ

Eγ − E ′
γ

cosϕ (1.19)

When the energy of the incident photon increases, the energetic transfer towards the elec-
tron Compton increases and the angle ϕ that makes its trajectory with that of the incident photon
decreases. Two extreme cases can be identified; the minimum and maximum energy transferred
to the recoil electron. Minimum energy transfer to recoil electron; θ=0; Eγmax = E ′

γ and
Eemin = 0

Maximum energy transfer to recoil electron; Head on collision in which θ=π
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Eemax = Eγ − E ′
γ = Eγ

Eγ

m0c2

1 + 2 Eγ

m0c2

(1.20)

Eemax = Eγ − E ′
γ =

Eγ

1 + 2 Ec

0.511

(1.21)

Note: A beam of photons of the same energy gives Compton electrons whose kinetic energy
varies between: Emin ≈ 0 and Emax

Therefore, the spectrum of Compton electrons is a continuous spectrum. The angular dis-
tribution of scattered photons in the solid angle dω about the direction θ relative to the direction
of the incident photon, is obtained from the differential section per electron. The theoretical
formula of Klein-Nishina giving this section effective is written:

dσe

dω
= r20[

1

1 + α(1− cos θ)
]2[

1 + cos2 θ

2
][1− α2(1 + cos θ)2

(1 + cos θ)2)(1− cos θ)
] (1.22)

where ro = 2, 818fm is the classical electron radius and α = hν
m0c2

The electron cross section σe is obtained by integrating the equation on all angles. Instead,
an effective cross section Compton per atom is used: σc= Z σe

Compton Cross section effect is proportional to Z and inversely proportional to the energy
Eγ of the incident photon.

σc ∝
Z

Eγ

(1.23)

Compton scattering is more important for photons with energy between 0.2 and 5.0 MeV,
and predominates in absorbents with higher atomic numbers.

Rayleigh scattering

Rayleigh scattering is also called coherent scattering because it is an elastic shock of a photon
with an electron strongly bound to the atom. In this case, the electron remains bound to the atom
since the binding energy of the electron is high and it is therefore the entire atom that stores the
shock energy of the photon. Thus, in a Rayleigh scattering, a large amount of motion can be
exchanged between the incident photon and the target atom without substantially exchanging
any energy [19]. The photon is at the end deviated from its initial trajectory which gives the
Rayleigh effect its importance. This type of interaction is frequent for media of high atomic
number and for low energy photons. This effect is often neglected in SPECT: for example,
in the NaI(Tl) and for an energy of 140 keV, the Rayleigh effect represents only 6% of the
interactions in the crystal, which is negligible compared to the photoelectric effect and the
Compton scattering

Measurement noise

The noise corresponds to a statistical fluctuation superimposed on the signal and possibly com-
ing from the detector (emission noise, counting noise) or reconstruction. Throughout the de-
tection chain, be it the radioactive emission of photons, the creation of photoelectrons in the
crystal, their conversion into electrons by the photocathode.
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1.4.2 Physiological factors
The physiological limits are related to the distribution of radiotracers in the patient and the
morphology of the patient. Indeed, radiotracers can be attached to other organs than that or
those specifically sought by the tracer. This then creates a background activity in the patient’s
body. As a result, the contrast of the images (difference in activity measured between the
region of interest and the background) is degraded. In addition, the quality of the images is
deteriorated because of the movements of the patient, whether inherent (heartbeat, breathing
...) or fortuitous (movement of the patient during the examination). This causes a blur on the
image and creates artifacts on the reconstructed images. Finally, the quality of the images is
dependent on the size and the morphology of the patient. Indeed, the larger the body of a
patient, the greater the proportion of attenuated photons and scattered photons in the tissues.
The statistics of counting the gamma camera is therefore lower, increasing the noise on the
image: the image is therefore of lower quality.

1.4.3 Technological factors
The technological limits are related to the components of Anger’s gamma cameras, and more
particularly to the detection module (NaI (Tl) scintillator and PMTs) and the collimator. These
limits are translated by the parameters of the detection module (spatial resolution, energy res-
olution, sensitivity, uniformity and geometric linearity), some are corrected online during the
acquisition by the processor, but others, whose spatial resolution, have very significant conse-
quences on the projections acquired and the reconstructed cuts: these consequences are pre-
sented below, as well as the effect partial volume.

Collimator response

The spatial resolution is determined by collimator-detector response (CDR). The CDR results
in a spatially varying and asymmetric reconstructed point spread function (PSF), leading to a
blurred tomogram and consequently significantly affects accuracy and precision of radioactivity
quantification.

Partial volume effect

The partial volume effect is defined as the loss of apparent activity in small objects or regions
because of the limited resolution of the imaging system. These results in an underestimation
of the radioactivity in the small volumes, even greater volumes become smaller. This effect
is present until the size of the object is approximately three times the spatial resolution of the
camera.

Septal penetration

Gamma rays that penetrate the lead septal of collimator can result in image degradation quality.
In parallel-hole penetration typically occurs when gamma rays cross from one collimator hole
to the next. With thicker septa, there is less penetration; however, more of the detector area
is obstructed, which degrades sensitivity. A proper trade-off is thus needed. A method for
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calculating the septal thickness, given a single-septal penetration of, e.g., 5% (which may be
considered acceptable for some tasks), was described in Refs. 84 and 85.

1.5 Ionizing radiation

1.5.1 Electromagnetic radiation
The radiation results from the emission of energy in the form of waves of particles. There
are two main types of radiation: ionizing radiation and non-ionizing radiation. Particulate or
electromagnetic radiation is ionizing when it is likely to tear electrons out of the material. For
this, it is necessary that the individual energy of the particles or photons is greater than the
minimum binding energy of the electrons of the medium considered. X-rays, gamma rays,
beta-rays (electrons) are all characterized by sufficient energy deposition to ionize the material,
but show strong differences in their precise modes of interaction. With it and, in particular,
with living matter. The γ and X radiation and are much more penetrating.

1.5.2 Gamma radiation
Gamma radiation is electromagnetic radiation emitted as a result of alpha or beta radiation
when they produce a new nucleus in an excited state. This excess energy is released in the form
of high energy photons with a high potential for penetration into matter.

1.5.3 X-rays
X-rays were discovered by Röntgen in 1895 and are not a natural phenomenon on Earth. X-
rays are a form of high-frequency electromagnetic radiation consisting of photons whose energy
ranges from a hundred eV (electron-volt), to about one MeV. X-rays are in the same range of
energy or frequency as gamma rays, but x-rays are extra-nuclear in origin, while gamma rays
come from nuclear decay (nuclear origin). X-rays can be produced in two very specific ways:
- X-rays are produced by electronic transitions involving the inner layers, close to the nucleus;
the excitation giving the transition can be caused by X-rays or by electron bombardment: com-
ponent of spectral lines
The bremsstrahlung radiation of electrons passing near a nucleus: continuous spectrum com-
ponent.

Component of spectral lines: Fluorescence radiation

The incident electron expels an atomic electron. There is then an electronic rearrangement, an
electron of a higher layer, to see a free electron, taking its place. During this rearrangement, a
photon X of characteristic energy of the transition is emitted. Often the rearrangement is done
with several electrons, several lines X are issued. X-rays are unique for each element as energy
emitted is proportional to the binding energy of the element.
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Spectrum component: Bremsstrahlung radiation

The electromagnetic radiation produced due to deceleration of a charged particle (electron)
when deflected by the atomic nucleus. Bremsstrahlung energy is released under shape of a
photon X or heat if the energy is low. The electron continues its course on another trajectory
having been deviated by the braking, until the following atom where it will produce another
photon X. Bremsstrahlung radiations have a continuous spectrum where as intense peaks of the
characteristic x rays can be seen on the spectrum. The probability of hitting the nucleus is very
small, to pass near the nucleus is low, and to pass away from the nucleus is high. The further
the electron passes near the nucleus, the higher the energy of the X photon. At the limit, all the
kinetic energy Ec of the electron is transferred to the X ray. Low energy X photons are the most
numerous, but they are reabsorbed more easily in the material; important heating. The coulom-
bic interaction is all the more important as the material is dense (high Z). The overall spectrum
results from the superposition of the continuous spectrum of Bremsstrahlung radiation (which
is predominant) and the line spectrum. Generally, when we speak of radiation/matter interac-
tion, three phenomena must be taken into account and depend on the initial energy involved.
These are photoelectric absorption, Compton scattering, Rayleigh scattering, and finally pair
creation if the starting energy is sufficient (greater than twice 511 keV). In the case of this study,
we will not be interested in the third type of interaction given the energy involved (less than
580 keV).

1.6 Spectrometry of electromagnetic radiation
Electromagnetic radiation is indirectly ionizing; any spectrometry performed using a scintil-
lator as a detector provides the energy spectrum of the electrons displaced or created by the
incident gamma or X-rays within the detector medium. The interpretation of this spectrum,
knowing the different modes of primary interactions (photoelectric effects, Compton and pair
creation) makes it possible to obtain quantitative information on the energy, the emission rate
of the incident radiation, by means of a calibration prior. All the phenomena that contribute to
the formation of an impulse have a random character.

1.6.1 Analysis of interactions in the scintillator: case of low energy elec-
tromagnetic radiation Eγ ≤ 1.02MeV

Consider a spectrometer equipped with a thallium-activated sodium iodide crystal (NaI). NaI,
like any scintillation detector designed for spectrometry, will deliver pulses whose amplitudes
are strictly proportional to the amount of light. This is also proportional to the energy of the
electrons set in motion by the incident radiation. If the energy of this radiation is less than 1.02
MeV, only the photoelectric and Compton effects can take place.

Photoelectric absorption

A photoelectron is set in motion following the interaction of the incident γ. Its most probable
energy is:

Eph = Eγ − Eki (1.24)
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(1) Eph: Photoelectron energy Eki: Electron energy of the K layer of the iodine atom
The energy of this photoelectron is entirely transferred to the scintillator by collision with
its electrons. The procession of the iodine atom is reorganized, leading to the emission of
electronic (Auger) or electromagnetic (X) radiation. Since these radiations have low energies,
they have a high probability of interaction in the scintillator. This one then recovers the sum
of their energies EKi. All these phenomena can not be distinguished by the detector; only the
total energy is taken into account.

Etot = (Eγ − EKi)− EKi (1.25)

(Eγ − EKi): energy of photo-electron
EKi :energy recovered during rearrangement
Eγ: incident radiation energy

It is possible that the most energetic rearrangement X-ray, Exki = (EK − EL)i
, escapes from the detector without interacting. The energy then recovered by the scintilla-

tor is equal to:

E ′
γ = Eγ − EXki = (EK − EL)i (1.26)

Following the photoelectric interactions two groups of pulses are delivered: - Those whose
maximum amplitude is proportional to Eγ

Vmax = kEγ (1.27)

- Those whose maximum amplitude is proportional to E ′
γ = Eγ − (EK − EL)i)

V ′
max = k[ Eγ − (EK − EL)i] (1.28)

In general the second group is quantitatively much less important than the first group. If
Eγ ≫ EXKi, the amplitudes are very close.

Compton scattering

A Compton electron is set in motion with energy equal to:

Ec = Eγ − E ′
γ (1.29)

This is transferred to the scintillator. The higher the energy of the scattered radiation E ′
γ , the

greater the probability that it has to escape from the detector without interacting. If it interacts,
it can do it either by photoelectric effect or by Compton effect. Since the detector can not
distinguish cascaded phenomena, because of their quasi-simultaneity, two groups of pulses are
distinguished: - those whose amplitudes are variable from 0 to a certain maximum value; they
correspond to initial Compton interactions followed or not by a partial absorption of the energy
of the diffused radiations produced. - those whose amplitudes are identical and proportional
to Eγ ; they correspond to initial Compton interactions followed by the total absorption of the
energy of the diffused radiations produced,
Vmax = kEγ

39



Chapter 1. Single Photon Emission Computed Tomography

1.6.2 Calibration, energy resolution
Calibration in energy

To perform the energy calibration of a gamma spectrometer, a number of radioactive sources
emitting gamma radiation whose energies are known with great precision are used. The am-
plitudes of the pulses corresponding to the total absorption lines are recorded on each of the
spectra obtained. The results obtained are then plotted on a graph paper, associating with each
measured amplitude (or the channel number), the corresponding reference energy. We draw the
curve joining the different points; for a good spectrometer it must be a straight line in a wide
range of energy. We can deduce: - The threshold energy Es which is the smallest energy that the
spectrometer can analyze due to the existence of an input threshold necessary to eliminate the
background noise produced by the different electronic units (preamplifier, amplifier, analyzer) .
- The slope k of the calibration line expressed in keV / mV or keV / channel for example. After
locating the total absorption lines of an unknown source and determining their position V, we
can deduce the energies of the emitted electromagnetic radiations using the relation:

E = kV + Et

Then the search for energy in the tables giving the various gamma emissions will eventually
identify the transmitter. If one refers to the course of radioactivity, the presence of a line of total
absorption of X-radiation in a gamma spectrum may be a valuable additional indication because
it allows to determine the descending element of the transmitter.

Energy resolution

The random nature of the phenomena used in a scintillation detector (light emission, emission
and electronic multiplication ...) causes a dispersion of the amplitudes of the pulses collected,
for identical energies ceded to the scintillator by the incident radiation. This phenomenon has
the effect of modifying the appearance of the spectra, in which, in particular, the total absorption
line is replaced by a total absorption peak.

1.6.3 Interaction of electromagnetic radiation outside the detector
The interaction of electromagnetic radiation in the scintillation detector environment may cause
additional peaks in the observed spectrum. Gamma radiation causes by photoelectric effect on
the materials surrounding the detector, the emission of X-rays characteristic of the products
used.

EKXα = (EK − EL)lead, EKXα = 74keV EKXβ = (EK − EM)lead, EKXβ = 85keV (1.30)

Gamma radiation causes, by the Compton effect on the materials surrounding the detector,
the emission of scattered gamma radiation. They produce a rather broad backscattering peak,
this being due to the energy dispersion, a consequence of the angular distribution. The energy
of the scattered radiation is obtained by the relation:

E ′
γ =

Eγ

1 + 2 Ec

0.511

, (Eγ)inMeV (1.31)
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Tomographic reconstruction methods in
SPECT

2.1 Tomographic reconstruction
A rotating gamma camera is obtaining 2D projection images of the 3D distribution of the
radionuclide at different angular positions. After data acquisition the 3D distribution of the
radioactive substance can be reconstructed using appropriate reconstruction algorithm. To-
mographic reconstruction consists in estimating the signal of interest that yielded the measured
projections using a mathematical algorithm. The reconstruction methods are used both in X-ray
transmission tomography such as scanner images and in gamma emission tomography such as
Single Photon Emission Computed Tomography (SPECT) images or PET (Positron Emission
Tomography) images. ). We will limit this presentation to the SPECT emission tomography,
since this is the framework of this thesis. In SPECT, the detection head of the gamma camera
rotates around the patient and makes acquisitions (called 2D projections) at different angles of
view (angle θ) of the radiotracer. The problem consists of reconstructing a volume (3D) of the
patient’s activity from these projections (2D). Because no information with projection operation
regarding the depth at which disintegrations occur is available; moreover, activities distribution
may overlap each other on the detector plane, and the contrast may be low. With only 1 pro-
jection image, it is impossible to determine the activity distribution because an several number
of distributions can yield the same projection. It is as difficult as to find 2 values knowing only
their sum. However, the overlap observed in the projections depends on the relative positions
of the detector and of the inside the phantom structures. To solve this inverse problem, we
use tomographic reconstruction methods, which we will present. Note that this 3D volume is
generally visualized in the form of 2D images, for example in the form of transverse (or axial),
coronal (or frontal), or sagittal sections. So, more information about the relative positions can
be obtained by acquiring projections over a large number of angles of view around the phan-
tom. The basic idea of SPECT is to determine the accurately position as possible. Consider the
cut of an organ containing a radioactive focus. The distribution of activity can be defined by a
function f (x, y) which at each coordinate point (x, y) of the cutting plane gives the value of the
radioactive concentration. The head of the camera will rotate around the organ and under each
incidence acquire a two-dimensional projection. We can define the one-dimensional projection
at the angle θ, p (u, θ), corresponding to the sum of the activity along the projection lines, by
the following expression:
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p(u, θ) =

∫ +∞

−∞
f(x, y)dv (2.1)

The fixed Cartesian coordinate system (O, x, y) is linked to the activity distribution f(x,
y) while the rotating marker (O, u, v) is associated with the gamma camera in rotation at
the incidence θ. f (x, y) the activity at point (x, y) under ideal conditions (no attenuation or
diffusion). The coordinates in both landmarks are linked by relations:

u = x cos θ + y sin θ (2.2)

x = u cos θ − v sin θ (2.3)

v = −x sin θ + y cos θ (2.4)

y = u sin θ + v cos θ (2.5)

The two-dimensional projection (2D) at the angle θ corresponds to the set of all the one-
dimensional projection lines (1D) at the angle θ along the z axis. It simply corresponds to the
2D image at the output of the detector obtained at the angle θ . The set of one-dimensional
projections for all angles θ ∈ [0, π] is the 2D Radon transform of f (x, y), whose graphical
representation is called the sinogram. The Radon transform has the following expression:

R[f(x, y)] =

∫ π

0

p(u, θ)dθ (2.6)

This Radon transform does not take into account the various disruptive physical effects (at-
tenuation, diffusion and photon noise). Inverting the Radon transform returns to solving the
inverse problem of tomographic reconstruction. In SPECT, the inverse problem consists in es-
timating the (3D) distribution of activity f from the acquired projections (2D). This is a problem
called "ill-posed problem" for two main reasons: The first reason is that the exact analytical
reversal of the tomographic reconstruction problem leading to a single solution is only possible
if the number of acquired projections is infinite. In practice, however, the number of projec-
tions acquired is limited (64 or 128 views), and the data acquired by the detector is sampled
and digitized, so that the solution determined is not unique. The second reason is the presence
of measurement noise (Photon noise Poisson kind (major), noise detection and Electronics).
The inversion of the Radon transform can be done either analytically or algebraically. A gen-
eral overview of analytic and iterative methods of reconstruction in SPECT is presented in this
chapter.

2.2 Analytical reconstruction methods
The analytical methods of reconstruction are based on an analytical inversion of the Radon
transform. They assume that the data are continuous and that the value of a projection is known
at each point (u, θ) of the sinogram.
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Figure 2.1: p(u, θ) projection of the activity distribution f (x, y) at the angle θ

2.2.1 Simple backprojection
The simplest analytical reconstruction algorithm is simple backprojection. This simple back-
projection makes it possible to estimate the activity distribution f * (x, y) by integrating the
projection p (t,θ) for all the values of θ. The projections are then simply projected in the oppo-
site direction. The mathematical expression of this simple backprojection is:

f(x, y)∗ =

∫ π

0

p(u, θ)dθ (2.7)

However, this simple back projection generates areas of nonzero activities where no activity
exists: these are the reconstruction artifacts, known as "artifacts star." These star artifacts de-
crease with increasing number of projections. One method also allows limiting these artifacts;
it is the method by filtered back projection.

2.2.2 Filtered backprojetion (FBP)
FBP is available on all commercial scanners (X-ray scanners, SPECT and PET devices) Bracewell
and Riddle in 1967, introduced the method called filtered backprojetion (FBP) method based
on Fourier Transform. The FBP is widely used due to low processing time and easy to use. It is
available on all commercial scanners (X-ray scanners, SPECT and PET devices). Theoretically,
under the assumption of a uniform attenuation in the studied object, filtered backprojection pro-
vides an exact solution of the inverse problem of tomographic reconstruction if the projections
were continuous and the number of angles of view infinite. The theorem of projections, also
called a center cut theorem (Central Slice Theorem-CST) facilitates the process. This says a
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1D Fourier transform of the Radon transform of the function corresponds to 2D Fourier trans-
form of the function. That is, performing the Fourier transform of the projections, one arrives
at the space frequency distribution of densities that wish to discover. Within the operations are
performed frequencies filtering and 2D inverse transform returns the reconstructed image.

p(ν, θ) =

∫ +∞

−∞
p(u, θ)e−2πiνudu (2.8)

By replacing p(u, θ) by its value given by the equation 2.14 , we have:

p(ν, θ) =

∫ +∞

−∞

∫ +∞

−∞
f(x, y)dve−2πiνudu (2.9)

The formulas for transforming Cartesian coordinates to polar coordinates give us:

νu = xν cos θ + yν sin θ = xνx + yνy (2.10)

In addition, we have dudv = dxdy
Finally, we have:

p(ν, θ) =

∫ +∞

−∞

∫ +∞

−∞
f(x, y)e−2π(ixνx+yνy)dxdy (2.11)

This double integral is none other than the two-dimensional Fourier transform of the activity
distribution to be estimated. The inverse Fourier transform for estimating f (x, y) from is written
as P(ν,θ):

f(x, y) =

∫ +∞

−∞

∫ +∞

−∞
P (ν, θ)e2π(ixνx+yνy)dνxdνy (2.12)

We can make the change of variable by replacing dνxdνy by νdνdθ using the Jacobian of
the transformation. The integration terminals of the variable θ become 0 and 2π. Due to the
symmetry with respect to the origin, the point(ν,θ ) has the same value as the point (-ν, θ + π):
we can therefore use the absolute value of ν to traverse the frequency plane and vary θ from 0
to π. The equation becomes

f(x, y) =

∫ π

0

∫ +∞

−∞
P (ν, θ)|ν|e2πiνudνdθ (2.13)

The internal integral represents the inverse Fourier transform of the Fourier transform of
the projection multiplied by the absolute value of ν: this internal integral is a filtered projection

P̂ (u, θ) =

∫ π

0

P (ν, θ)|ν|e2πiνu (2.14)

It is therefore possible to reconstruct f (x, y) by which is none other than the rear projection
of the filtered projections. The projections are filtered using the ramp filter, noted |ν| in equa-
tion. The ramp filter sets the constant component to zero, which introduces negative values and
amplifies the high frequencies. In practice, the ramp filter introduces negative values on either
side of the filtered object, which gradually erase the star artifacts left by the projection step.
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f(x, y) =

∫ π

0

P̂ (u, θ)dθ (2.15)

The filtering used is the ramp filter, which makes it possible to obtain good spatial reso-
lution. However, this filter has the effect of amplifying very high frequencies, so noise. It is
then weighted by an apodization filter, for example the Hann and Butterworth filters (the most
frequently used).

2.2.3 Filters used with the filtered backprojection
The filtering used is the ramp filter, which allows obtaining good spatial resolution. However,
this filter has the effect of amplifying very high frequencies, so noise. It is then weighted by
an apodization filter, for example the Hann and Butterworth filters (the most frequently used).
Other filters are sometimes used, such as the Hamming filter or the Gaussian filter. Hann’s filter
[20] esponds to a cosine function in the frequency space and its formula is given by:{

H(ν) = 0.5(1 + cos π ν
νc
) if ν ≤ 0

H(ν) = 0 if ν ≥ 0

The parameter νc s called the cut-off frequency of the filter: the lower it is, the smoother
the filter, which results in a high attenuation of the noise but also in a loss of details at high fre-
quency, and therefore of resolution, and sometimes a modification of the medium frequencies.
This filter allows extremely fast calculations.

Another filter frequently used is that of [21]: it depends on two parameters, the cutoff
frequency νc er order n which determines the rate of decay in the high frequencies. Its formula
is given by the equation: {

1√
1+( ν

νc
)2

if ν ≤ 0

H(ν) = 0 if ν ≥ 0
(2.16)

If correctly set, the Butterworth filter also preserves the mid frequencies and therefore the
resolution. The higher the order n, the lower the smoothing is stronger and less high frequencies
is preserved. FBP works if data are not very noisy and if the measurement can be accurately
modeled as a Radon transform.

2.3 Algebraic reconstruction methods
Algebraic methods are based on the discrete and matrix expression of tomographic reconstruc-
tion problem. The problem is to solve a system of large linear equations. The projections p
are described in the form of a vector of dimensions nθ N2, where nθ denotes the number of
projections under which the object is seen by the detection system (number of angles of view)
and NN the sampling of the detector, that is to say the number of detection pixels. The activ-
ity distribution in the studied volume is described by a vector of dimensions V 3, representing
the number of voxels 3D volume to rebuild. The components of the projection vector and the
activity distribution vector are respectively denoted pk

and fi, where k ∈ [1, nθ ×N2] et i ∈ [1, V 2].
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A matrix, named R, makes it possible to connect the projections and the object of the
distribution of activity according to the matrix expression [p] = [R]. [F]. The discrete Radon
transform is then written:

pk =
n∑
i

rijfj (2.17)

R represents the matrix of the Radon operator of dimensions (nθ ×N2 , V 3), and each rki
element of

the matrix R represents the probability that a photon emitted by the ith voxel object is
detected by the kth detector pixel. The rki coefficients of the matrix R are difficult to assess,
and must be each acquisition geometry. They can integrate the physical effects degrading the
image such as the attenuation of the object and the septal transparency of the collimator. The
inverse problem therefore aims to estimate the activity distribution of the object volume f (3D)
knowing the acquired projections p (2D) and the matrix R. A simple reasoning would be to
say that f = R−1p. However, the R−1 matrix inversion of the projection operator R is often
impossible because of its dimensions (a non-square matrix R is non-reversible, and a square
matrix too large is very difficult to reverse, the often impossible). In addition, the measurement
noise and the approximation of modeling are an exact solution does not exist: we seek an
approximate solution by iterative method. This approximate solution is an estimate of the
object f .

There are three categories of algebraic algorithms: Iterative statistical methods, which take
into account the statistical nature of the acquired data and include the Maximum Likelihood
Expectation Maximization (MLEM) method and its accelerated OSEM (Ordered-Subsets Ex-
pectation Maximization) version. Filtered back-projection algorithms iterative, based on the
FBP algorithm presented in section II.2.1 and were originally developed to correct the atten-
uation images obtained by FBP. conventional iterative algebraic methods, which reconstruct
the projections by solving a set of linear equations defined by equation II.21: these methods
include the ART (Algebraic Reconstruction Technique) method, the SIRT (Simultaneous Itera-
tive Reconstruction Technique) method ) [Herman, 1980], the descent method and the gradient
methods. We present here only the MLEM method and the OSEM method that were used
during this thesis work.

2.3.1 Statistical iterative methods
We interest in finding a vector f that is a solution of g = A.f The principle of the iterative
algorithms is to determine a solution by successive estimates. The measured projections are
compared with the projections corresponding to the current estimate. The result of the compar-
ison is used to modify the current. The algorithms differ in the way the measured and estimated
projections are compared and the kind of correction applied to the current estimate. The pro-
cess is initiated by arbitrarily creating a first estimate for example, a image initialized to 0 or 1.
It depending on whether the correction is carried out under the form of an addition or a multi-
plication). Statistical methods are based on a probabilistic representation of the problem. They
assume that the projections contain a statistical noise. So the measurements and the object are
supposed to be random variables. These statistical methods seek the object f the more likely
given the p observed projections.
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The Maximum Likelihood Expectation-Maximization (MLEM) method

In SPECT imaging the Maximum Likelihood Expectation Maximization (MLEM) algorithm
is a popular reconstruction method, although the MLEM based image reconstruction is a time
consuming process especially in the case if we use it with attenuation correction and compen-
sation for the distance dependent spatial resolution of the detector.

The MLEM method was first developed for PET tomography by Shepp and Vardi [22], and
then for transmission tomography [23] and for SPECT [24].

It assumes that numbers of both the emitted and the detected disintegrations are considered
to be Poisson random variables. Let us consider fj, the mean number of disintegrations in pixel
j, and the element rij of the matrix Rij , the probability that bin i detects a photon emitted from
pixel j. The mean number of photons emitted from pixel j and detected by bin i is a rij f̄ .
The mean number of photons r̄ij detected by bin i is the sum of the mean numbers of photons
emitted from each pixel:

p̄i =
n∑

j=0

rij f̄j (2.18)

It shows that the number of photons emitted from the n pixels and detected by bin i is a
Poisson variable. The probability of detecting pi photons is given by:

P (pi) =
p̄pii e

p̄i

pi
(2.19)

The maximal probability is reached when the number of counts is equal to the mean number
P (pi = p̄i). The i Poisson variables are independent, and the conditional probability P (p | f̄)
of observing the vector g when the emission map is f̄ is the product of the individual Prob-
abilities P (pi). we can easily compute the likelihood function L(f̄), so we can use the EM-
algorithm to estimate f . We find for the likelihood function

L(f̄) = P (p | f̄) = P (p1)P (p2)P (p3)...P (pn) (2.20)

L(f̄) =
n∏

i=1

p̄pii e
p̄i

pi
(2.21)

The highest value for the likelihood L(f̄) is found by computing its derivative. To maximize
the expectation, one usually considers l(f̄) = lnL(f̄).

l(f̄) =
m∑
i=1

(−p̄i + pilnp̄i − lnpi!) (2.22)

l(f̄) =
m∑
i=1

(−
n∑

i=1

rij f̄j + piln
n∑

i=1

rij f̄j − lnpi!) (2.23)

This equation, called the likelihood function, is of fundamental importance in the MLEM
algorithm, because it allows one to calculate the probability to observe a projection dataset for
any mean imagef̄ . Obviously, we want the image that has the highest probability to yield g, so
the essential point here is that the vector f̄ for which l(f̄) is maximal is considered as the best
estimate for the solution. This maximum is found when the derivative of l(f̄)is zero:
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l(f̄) = −
m∑
i=1

fij +
m∑
i=1

pi∑n
k=1 rij f̄j

= 0 (2.24)

One can also write:
The MLEM algorithm estimates f (n+1)

j from the estimate fi(n) by a multiplicative correction
factor c(n). This algorithm is written in the form:

f̄j
(n+1)

=
f̄j

(n)∑m
i=1 rij

n∑
i=1

pi∑n
k=1 rij

¯
f
(n)
k

(2.25)

Where i and j are respectively the indices of the object voxel and the detector pixel.
f̄k

(n)
f̄j

(n+1) are the estimates of the jth voxel of the object respectively at iteration n and
n+ 1.

The MLEM algorithm has some interesting properties, in particular: - If the initial estimate
f̄j

(0) is a positive distribution, then all the following estimated distributions will be positive; -If
a pixel has a zero value at initialization, this value remains zero; The EM algorithm can be seen
as a set of successive projections/backprojection:

pi∑n
k=1

¯
f
(n)
k

(2.26)

This factor is the ratio of the measured number of counts to the current estimate of the mean
number of counts in bin i:

n∑
i=1

pirij∑n
k=1

¯
f
(n)
k

(2.27)

This is the backprojection of this ratio for pixel j. Equation*, which is to be applied pixel
by pixel, can be extended to the whole image and interpreted as: Image(k+1) = Imagek

Normalized Backprojection of (Measured projections)/projections of image(k) ) The measured
projections are then compared with simulated projections of the current estimate, and the ratio
between these simulated and measured projections is used to modify the current estimate to
produce an updated (and hopefully more accurate) estimate, which becomes iteration k + 1.
- The total number of events is kept at each iteration. But this algorithm also has two major
drawbacks: slow convergence and instability from a large number of iterations.
- This process is then repeated many times. The MLEM algorithm converges slowly: it can
require up to a hundred iterations, which makes its delicate use in clinical routine. Among
the existing acceleration methods are the OSEM method. The MLEM algorithm is unstable
after a large number of iterations in the case of noisy data. This brings up edge artifacts and
amplification of high frequencies (spatial resolution and computation noise). Thus the num-
ber of iterations directly affects the compromise between spatial resolution and noise in the
reconstructed images. The simple solution of stopping the iterations before amplification of the
measurement noise is therefore not optimal because it is possible to stop the algorithm before
its convergence.

The FBP algorithm is faster than iterative algorithms, with the latter providing a framework
for accurately modeling the emission and detection processes.
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Ordered Subsets Expectation Maximization method

The OSEM (Ordered Subsets Expectation Maximizations) method is the accelerated version
of MLEM. It was developed by Hudson [25] to improve the speed of convergence of MLEM.
It consists of grouping the projections into ordered subsets (Figure III-41) before applying
the MLEM method. The number of subsets determines the acceleration factor relative to the
MLEM method. For example, a 5-iteration OSEM-8 subset reconstruction is equivalent to a 10-
iteration OSEM-4 subset reconstruction, and equivalent to a 40-iteration MLEM reconstruction.
It is useful for each subset to contain projections equally distributed about the patient, to help
promote convergence of the algorithm. The MLEM is then applied to each subset in turn, as
a subiteration. The first full iteration is complete when all subsets have been processed. Thus
considerably shorten the computing time needed for reconstruction.

Statistical iterative methods regularized

In the case of heavily noisy data, the MLEM algorithm is unstable after a large number of
iterations and noise then appears in the reconstructed object. The solution, to limit this noise,
is to use the so-called regularization methods. These are methods based on the introduction
of constraints (spatial, probabilistic) on the radioactive distribution sought in the object, thus
allowing the estimated distributions to be stabilized. Note, however, that there is no standard
regularization method. The introduction of a constraint on the radioactive distribution sought in
the object is achieved by introducing a priori on the object (prob(f) 1). The goal is to maximize
the likelihood function:

argf max[L(f)] = arg[prob(p|f) + prof(f)] (2.28)

The prior knowledge of what the reconstructed image should be is introduced in the EM
algorithm using Bayes theorem. It states that:

P (f̄/p) =
P (p/f̄)P (f̄)

P (p)
(2.29)

where P (f̄/p) is the likelihood function P (f̄) , the prior function, defines the a priori
knowledge of the image; P (p) is the a priori probability distribution of the measurements;
P (p/f̄)P (f̄) is the a posteriori probability distribution of the image. Taking the logarithm of
both sides of Equation yields:

ln[P (f̄/p)] = ln[P (p/f̄)P (f̄)]− lnP (p) (2.30)

A common Bayesian prior to enforce local smoothness is the Gibbs prior, with

P (f̄) = Ce−αU(f̄)) (2.31)

where C is a constant, λ is a regularization parameter and U(f̄) is a potential function of f̄ ;
λ is the weight of the prior and C is the weight of the prior and is a normalizing constant. The
regularized MLEM algorithm proposes to estimate the object to be reconstructed by finding the
maximum log-likelihood function [26] given by the equation:
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ln[P (f̄/p)] =
m∑
i=1

[(−
n∑

i=1

rij f̄j + piln

n∑
i=1

rij f̄j − lnpi!]− αU(f̄) + lnC − lnP (p) (2.32)

Again, the derivative of ln[P (f̄/p)] is used to find the image f maximizing ln[P (f̄/p)]

∂ln[P (f̄/p)]

∂f̄j
=

m∑
i=1

−rij + f̄j

m∑
i=1

pi∑n
k=1 rikf̄k

rij − λ
∂U(f̄j)

∂f̄j
(2.33)

The regularized MLEM algorithm can then be written as:

f̄j
(n+1)

=
f̄j

(n)∑m
i=1 rij + λ

∂U(f̄j)

∂f̄j

n∑
i=1

pi∑n
k=1 rij

¯
f
(n)
k

(2.34)

In the literature many potential functions are listed [27, 28, 29, 30] . For example, the
quadratic potential (Geman et Geman) [30], allows taking into account the weighted average
of the neighbors (b) of the voxel object (i), according to the expression:

f̄j
(n+1)

=
f̄j

(n)∑m
i=1 rij + 2λ

∑
a ωja(fj − fa)

m∑
i=1

pi∑n
k=1 rij

¯
f
(n)
k

(2.35)

With wib the neighbor weighting factor (b), which satisfies Equation∑
a

ωja = 1 (2.36)

The regularized method called MRP (Median Root Prior) [30, 31, 32] allows the median
Mi value of the neighbors (b) of the voxel object (i), according to the expression:

f̄j
(n+1)

=
f̄j

(n)∑m
i=1 rij + λ

fj−Mj

Mj

m∑
i=1

pi∑n
k=1 rij

¯
f
(n)
k

(2.37)

This OSEM-MRP method tends to render the image locally monotonous, while preserving
transitions at the edges of objects [33]. By correctly selecting the value of λ, the regulation
parameter, the MRP method allows to control the noise, while obtaining contrast close to those
obtained by MLEM.

This chapter reviews the problem of tomographic reconstruction in SPECT and presents
the most used reconstruction algorithms, namely FBP, MLEM and OSEM. These are the algo-
rithms of the reconstruction methods used in my thesis.
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Monte Carlo Simulation

Monte Carlo simulation technique was used widely in medical physics application. and are an
invaluable aid to treat various problems, among which the design and optimization of imag-
ing devices (collimator, detector ...) or the development and reconstruction algorithms. Monte
Carlo modeling has been carried out by various simulation codes. In nuclear medicine Monte
Carlo (MC) simulation studies are today an essential tool in a number of applications in area of
emission tomography. Such applications for both single photon emission tomography (SPECT)
and positron emission tomography (PET) include, among others, optimization of system design
for new scanners, study of factors affecting image quality, validation of correction methodolo-
gies for effects such as scatter, attenuation and partial volume, as well as development of new
reconstruction algorithms. Also use in internal dosimetry. Monte Carlo techniques simulate the
random trajectories of individual particles by using machine-generated (pseudo-)random num-
bers to sample from the probability distributions governing the physical processes involved [2],
The main advantage that all known physical interactions can be modeled fairly well. And it is
practical for most applications also it can be utilized for general geometries in 1-D, 2-D, and
3-D

3.1 Review of existing simulation codes
Two types of simulation codes are available: generic codes, developed for the needs of high
energy physics and dosimetry, are very comprehensive but also complex to use and not always
adapted to the needs of nuclear imaging, and codes specifically designed specifically for PET
and SPECT requirements, they are easier to use but also less flexible and less durable. So, there
is currently no standard simulation code for nuclear imaging, which is both flexible enough to
allow the simulation of original devices and validated, therefore reliable, in a large number of
configurations SPECT and PET. Monte Carlo modeling has been carried out by various sim-
ulation codes such EGSnrc (electron gamma shower National Research Council of Canada),
MCNP (Monte Carlo Neutron Photon), GATE (Geant Application for Tomographic Emission),
and dedicated codes such as SIMIND, SimSET(The simulation system for emission tomogra-
phy), SORTEO(Simulation Of Realistic Tridimensional Emitting Objects),especially designed
for Single Photon Emission Computed Tomography (SPECT) and Positron Emission Tomog-
raphy (PET).

51



Chapter 3. Monte Carlo Simulation

3.2 Monte Carlo simulation software SIMIND

3.2.1 Introduction
Monte-Carlo methods are statistical methods based on the drawing of random numbers accord-
ing to probability laws (or probability density functions) that describe the physical processes
studied. Monte-Carlo methods are commonly used to solve complex mathematical or physical
problems, to which analytical or numerical calculations can not provide a solution. They prove
to be particularly adapted to medical physics because of the stochastic nature of the processes
of emission, transport and detection. These different processes are governed by probabilistic
laws: for example, the interactions of particles in matter are described by interaction cross sec-
tions representing the probability that the particle will interact in the medium. Improvements
in theoretical models describing physical processes in statistical physics and particle physics
have directly benefited Monte Carlo methods. The Monte Carlo method is based on the sam-
pling of probability density functions by random number draws. To simulate each step of a
physical process (particle generation, particle interaction), several random number draws may
be required. The generation of random numbers is therefore a crucial step in Monte Carlo
methods.

The Monte Carlo simulation program SIMIND (SIMulation of Imaging Nuclear Detectors)
[5] is available in the public domain and downloadable free
https://www.msf.lu.se/research/the-simind-monte-carlo-program. It has been developed by Pro-
fessor Michael Ljungberg at the Department of Medical Radiation Physics, Lund University,
Sweden. SIMIND is Monte Carlo-based simulation program that simulates clinical SPECT sys-
tems and can easily be modified for almost any type of calculation encountered in SPECT (Sin-
gle Photon Emission Tomography) and planar imaging. A large parameters are made possible
to manipulate in order to simulate different gamma camera from different manufacturers. When
simulating SPECT, the camera rotates in the ZY plane either clockwise or counter-clockwise

Figure 3.1: The coordinate system

The drawback with SIMIND is only simulates photons and omits the secondary electrons
created through interaction in the phantom. The photon energies used in SPECT are however
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relatively low and this is usually not a problem. Two main programs are used in order to set
the simulations. CHANGE program and the SIMIND simulation program. The CHANGE
program provides a menu-driven way of defining necessary parameters for the system that will
be simulated.

The system values that are set here will be saved as input files for SIMIND which then
is the program that actual makes the Monte Carlo simulation. The result from the SIMIND
is then written to various results files including energy spectrum and projection images. The
common way of running SIMIND is by using command files. This is very convenient since each
simulation usually takes considerably time. SIMIND contains several simulation flags which
the user easily can turn on and off. These flags represent different features such as SPECT
simulation, simulation of photon interaction in the phantom, the addition of a collimator and a
backscattering compartment behind the crystal and so on.

The SIMIND program provides images that are normalized to represent a measurement of
an activity distribution. The images are also stored as floating point values. The program is
based on the use of uniformly distributed random numbers for modeling the processes of the
different photon interactions. It simulates the passage of photons through a phantom and col-
limator towards the detector crystal and calculates the projections. As in reality, the detection
of the photons is affected by attenuation, scatter, the collimator and characteristics of the scin-
tillation crystal among other things. Septal penetration and characteristic x-rays, emitted from
photoelectric absorption in the collimator, can also be simulated if desired. The advantage of
this Monte Carlo simulation is that it calculates parameters that are not directly measurable in
experimental measurements, such as the Scatter to Total ratio (S/T) which is the fraction of
the detected photons that are scattered, owing to the fact that the program can tell whether a
detected photon is primary or scattered. The user can at run times change the input parameters,
originally created by GANGE. each value defined by an index numbers in CHANGE can be
overridden by giving a corresponding control switch eat run time. The advantage with option
is that only one data file is necessary for multiple simulations.

3.2.2 Scoring routines
The following scoring routines are now included in simind.

The scattwin scoring routine

This routine performs multiple window simulations easily without the need for programming.
The structure of the file is relatively simple, as shown in the following example: For easy
use of the simind-generated scatter images and for the castor reconstruction program, it is
possible to write two keywords in the *.win file depending on whether you select the double
energy windows (DEW) method or the triple energy window (TEW) method. The structure of
the file is relatively simple, as shown in the following example: 126.0,154.0,0 154.0,157.0,0
123.0,126.0,0 The files created by scattwin have the format

out_airw1.a00
out_totw1.a00
out_scaw1.a00
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The DEW method: The scatter is estimated on the basis of the previous energy window. For
example, assume this energy window file: 126.0,154.0,0 92.0,124.0.74,dew This now works in
such that the scatter file for the second energy window 92-124 is scaled to match the energy
window in the previous setting, i.e. the scaling factor will be [154- 26]/[124-92]. In addition,
the data will be scaled optionally by the constant 0.5. Thus, the total scaling will be [154-
126]/[124-92]*0.74. The TEW method: This works as follows. Assume an energy window
file as in this example: 126.0,154.0,0 154.0,158.0,0 122.0,126.0,1.0,tew The scatter data in the
third window will then be scaled by the factor [Data2*W2 + Data3*W3]*0.5 * W1, where W1
= [154-126], W2 = [158-154], and W3 = [126- 122]. Here, there is no optional scaling, i.e.
the factor is 1.0 but there could have been a value. The BIS file saved by this routine contains
spectra for the total photons (spectra t), primary unscatter spectrum (spectra-p) and scattered
photons (spectra-s) and the for each of the scatter orders selected (1, 2, 3, 4 ...). The spectra
can be extracted using the bis program, e.g.

bis spectra spectra-t/spe:1 Extracted spectra = the total events bis spectra spectra-p/spe:2
Extracted spectra = the primary events bis spectra spectra-s/spe:3 Extracted spectra = the scatter
events bis spectra spectra-fso/spe:4 Extracted spectra = the first scatter order

The forced collimation scoring routine

This is an option of including a forced collimation in the simulation to speed up the simula-
tion. Owing to technical reasons, this option cannot be made as an ordinary collimator routine.
Instead, it must be a scoring routine. The principle of the method is that multiple images are
created on the basis of the distance between the lower collimator surface and the last interaction
point. When the simulation of a certain projection is completed, each of these multiple images
is convolved with a Gaussian function with sigma calculated from the distance between the
plane for those interaction points and the camera surface. Subsequently, the images are added
to a final image. The following assumptions have been made:
The ordinary collimator is turned off and the direction of the photon after the last interaction
point is directed perpendicular to the crystal surface. The attenuation is then calculated on the
basis of the distance from the last interaction point to the surface of the phantom. This means
that the difference in attenuation as a function of the azimuthal angle close to the surfaces is
not taken into consideration.
The shape of the Gaussian will be symmetric.
No backscatter from the volume behind the crystal is included.
No events from penetration or scatter in the collimator are included.
Finally, the images will be saved to *.bim or *.a00 files. Note: Because this technically is a
scoring routine, it is not possible to combine this feature with the Scattwin, Penetrate, or List
Model routines in this version.

The penetrate scoring routine

This scoring routine separates the components of an image or spectrum. Further, 18 different
images and energy spectra are stored. The content in the energy spectrum file follows the order
of appearance described above, but different spectra are stored in a single file. *.b01 All type of
interactions. *.b18 photons without scattering and attenuation in the phantom. *.b19 photons
without scattering and attenuation in the phantom and geometrically ollimated for primary
photon energy (indicated by a negative energy in the *.isd file).
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The following files are with no backscatter from the compartment behind the crystal and
show events coming from.
*.b2 Geometrical collimated primary attenuated photons from the phantom.
*.b3 Penetration of a septa from primary attenuated photons from the phantom.
*.b4 Scatter from the collimator from primary attenuated photons from the phantom.
*.b5 X-rays from the collimator from primary attenuated photons from the phantom.
*.b6 Geometrical collimated from scattered photons from the phantom.
*.b7 Penetration of a septa from scattered photons from the phantom.
*.b8 Scatter from the collimator from scattered photons from the phantom
*.b9 X-rays from the collimator from scattered photons from the phantom.

The following files are with backscatter from the compartment behind the crystal and show
events coming from.
*.b10 Geometrical collimated primary attenuated photons from the phantom.
*.b11 Penetration of a septa from primary attenuated photons from the phantom.
*.b12 Scatter from the collimator from primary attenuated photons from the phantom.
*.b13 X-rays from the collimator from primary attenuated photons from the phantom.
*.b14 Geometrical collimated from scattered photons from the phantom.
*.b15 Penetration of a septa from scattered photons from the phantom.
*.b16 Scatter from the collimator from scattered photons from the phantom
*.b17 X-rays from the collimator from scattered photons from the phantom.

The content in the energy spectrum file follows the order of appearance described above,
but different spectra are stored in a single file.

The listmode scoring routine

This routine saves information about the photon history in a binary list mode file. The file will
have the extension *.lmf. To save disk space, each record of a history in the binary file will
have nine 16-bit integer values, one 32-bit float value, and one 8-bit value in the order indicated
in the table. To preserve the decimal precision, the floating values have been multiplied with
a scaling factor before being truncated to integers. Therefore, you should divide the values by
the corresponding scaling factors before using them.

3.2.3 Source routine
The following source routines are included in SIMIND

The image-based sources source routine

This simulates a source distribution in three dimensions by using the information in a file that
contains integer matrices when generating the location for the decays in the phantom. With this
procedure, very geometrically complex source distributions can be simulated in a relatively
easy manner. The routine simulates decays randomly within the voxel volume corresponding
to the location of the source map voxel. The number of decays from that location is determined
from the contents of the source map voxel. A pixel size (/PX described below) is needed for
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conversion to physical coordinates because the location to a matrix cell is referred by relative
indices (i, j, k). Note that this pixel size has no connection to the pixel size that defines the
projections being simulated. A tumor file can be read into the source map routine and the count
is incremented according to the definition in the tumor file. One tumor is defined by one row in
the file as floating-point values separated by a space. Instead, the number of photon histories is
determined by calculating the sum of the voxel values in the source map.

The myocardiac source routine

This is a source routine that simulates a heart consisting of a combination of a half sphere
shell and a cylindrical shell, both with the same thickness. The source distribution can very
accurately be matched to the physical cardiac insert manufactured by DataSPECTRUM Inc.
A defect can be inserted in the half cylinder at an arbitrary location. The multiple spheres
source routine This source routine simulates a Jaszczak cylindrical uniform source phantom
(Data Spectrum, Inc., Chapel Hill, North Carolina). The sources must be defined in an input
text file with the extension *.inp. The input file: This file is an ASCII file where each row
defines a sphere. Float 32-bit valuesseparated by a comma are used. . The values at the first
three positions define the size of the source. The values at positions 4-6 are the location in the
coordinate system for the centre of the source. Note that this is not the centre of gravity but
the starting point for each of the axes that define the ellipsoid. The value at position 7 in the
row is a relative value of the desired activityconcentration (MBq/cc). The value at position 8
determines whether the source shape will be a sphere (0.0) a cylindrical horizontal rod (1.0)
a rectangular horizontal rod (2.0) a hexagonal horizontal rod (3.0) a cylindrical vertical rod
(4.0) a cone (5.0)

3.2.4 Running SIMIND
A simind command at the operating system prompt consists of the following parts: The pro-
gram name, simind. An input file (optional). An output file (optional). Control switches
(optional)

The example below considers a Windows operating system with possible differences from
other operating systems in the prompt and the upper case of the characters simind input output/

Example of the program running on a PC

The user can control the input parameters created originally by change at the command level.
This means that a single data file (e.g. input.smc) can be used for multiple simulations. Each
value given by an index or by a flag in change can be overwritten by a matching control switch.
By giving a two-character alphanumeric corresponding value, this new value takes precedence
over the value defined by change. Additional characters may be given for clarity but only the
first two are used.

The bim program

The bim program performs calculations on the created projection image in the *.bim file. The
program is invoked in the same manner as simind, i.e. giving an input file name and additional
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switches after the program name. bim input output/switches. BIM outputs a very simple ’im-
age’, based on keyboard characters, of the matrix together with calculated data and a two-row
data of a profile through the matrix. The profile can then be plotted or included in a spreadsheet
program for further analysis.

3.2.5 The bis program
The bis program works on the calculated energy spectra from simind. It generate a two-column
ASCII string of the spectra to be used for plotting.. The program is invoked in the same manner
as simind. bis input.bis output.prn/switches

The smc2castor program

The simind only creates projection images and no reconstruction software is included or sup-
ported. It is possible on some clinical systems to import the Interfile file, it is often difficult
and requires a deeper understanding of the Interfile file format and how to make simind to
write such a file properly. In March 2017, the Castor reconstruction software was released
for download in the public domain. Information about the program can be found by visiting
http://castor-project.org/. CASToR is an open-source multi-platform project for 4D emission
(PET and SPECT) and transmission (CT) tomographic reconstruction. This platform is a scal-
able software providing both basic image reconstruction features for "standard" users and ad-
vanced tools for specialists in the reconstruction field, to develop, incorporate and assess their
own methods in image reconstruction (such as specific projectors, optimization algorithms, dy-
namic data modeling, etc) through the implementation of new classes. The general syntax for
the program is

smc2castor smcspectprojs.h00 resultfile [scatter file]/switches
where smcspectprojs.h00 is the header file for the simind SPECT simulation and resultfile

is the result file for the reconstructed data. The smc2castor program creates a castor file and
can spawn a reconstruction by adding the switch /ru.

The collimator database
This file includes data for the most common collimator files. It is based on a 6-character

code that is associated with the dimensions of the collimator. The user can easily modify this
file and add new collimators. If a user lacks some common collimators and wants to include
them for other users, please send the data to Michael so that he can include them in this file for
further releases. The result-file simind calculates some basic detector parameters by default.
These appear on the screen and in the result file (*.res) together with the input parameters,
defined in change. Collimator data are only written to the result file if a collimator has been
included. SPECT input parameters are written only if the SPECT flag is set. Moreover, the
scatter fraction and the percentage scatter, described below, are only written if a phantom has
been simulated.

3.2.6 Some examples
Spatial resolution Simulation

Simulate the spatial resolution for a bar phantom and Tc-199m as a function of distance and
collimators. Display the planer images using ImageJ program. Run the simulations with the

57



Chapter 3. Monte Carlo Simulation

(a) LEHR-10 (b) LEHR-30 (c) LEGP-10 (d) LEGP-30

(e) MEGP-10 (f) MEGP-30 (g) HEGP-10 (h) HEGP-30

Figure 3.2: Simulate the spatial resolution for a bar phantom and 140 keV photons as a function of distance
in (cm) and Low energy high resolution (LEHR), Low energy all purpose (LEGP), Medium energy (MEGP) and
High energy (HEGP) collimators

following command.
simind lehr lehr1/fi:tc99m/px:0.15/th:0.1/dir:3/12:30/29:5/12:10
simind lehr lehr2/fi:tc99m/px:0.15/th:0.1/dir:3/12:30/29:5/12:30
simind legp legp1/fi:tc99m/px:0.15/th:0.1/dir:3/12:30/29:5/12:10
simind legp legp2/fi:tc99m/px:0.15/th:0.1/dir:3/12:30/29:5/12:30
simind megp megp1/fi:tc99m/px:0.15/th:0.1/dir:3/12:30/29:5/12:10
simind megp megp2/fi:tc99m/px:0.15/th:0.1/dir:3/12:30/29:5/12:30
simind hegp hegp1/fi:tc99m/px:0.15/th:0.1/dir:3/12:30/29:5/12:10
simind hegp hegp2/fi:tc99m /px:0.15/th:0.1/dir:3/12:30/29:5/12:30

where /12: indicates the distance from the detector to the source. /PX is a switch that
defines the pixel size of the image of the bar phantom

(rodellh.smi),
which is used for the simulation. This pixel it not the same as the pixel of the image that

simind calculates. /TH is the rods thickness, /DIR is the direction of the source. The bim images
are stored as float 128×128 in the files that have the extension .bim. during the simulation, we
collected 5 million of photons.

Jaszczak SPECT simulation

Jaszczak SPECT simulation consists of using spheres of different sizes and locations inside a
cylindrical filled-water phantom. The jaszak.inp file give the shape, location, and activity of the
six spheres. The source routine reads data from jaszak.inp, in which each row defines a sphere.
We started the simulation by following command:

simind jaszak output
The output files are, in addition to the res file, a file called jaszak1.a00, which contains 64

float 64×64 projections. Moreover, the file jaszak1.h00 is stored, which is an Interfile header.
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Figure 3.3: The reconstructed images of simulated Jaszczak phantom SPECT for comparing image contrast of
six hot spheres with different diameters: 9.5, 12.7, 19.1, 15.9, 25.4, and 31.8 mm

We can made cold-spot simulation where the spheres activity is removed and assumed to
be disabled while the rest of the phantom is assumed to be uniformly filled with activity. We
perform the simulation by the command. simind jaszak jaszak2/co

We can using the activity in the spheres defined by the values in the inp file as well as
background activity equal to the value defined by the /bg switch. In this case we use the
following command: In the following case: simind jaszak jaszak3/bg:0.5

Simulation of bone-scan using an MDP-like radiopharmaceutical (SPECT)

The Zubal phantom consists of a set of 8-bit-coded images where each voxel has a unique
value. This is related to the organ or structure that the voxel belongs to. These coded images
define either density maps or activity maps provided that the user has appropriate density and
activity values. It is easy to use this phantom bi SIMIND. The program reads in the 8-bit-coded
images and from a special user-written table, creates activity maps. A special file called

mdpect.zub is used.
The file is of ASCII type and consists of four columns 1. The organ name , 2. The unique

code of that organ, 3. The density value, expressed as g/cm3*1000, and 4. A value representing
the activity concentration (MBq/cc). The following example performs a simulation of an MDP-
99m-Tc SPECT.

simind mdpect mdpect1/tr:11
Here, the file mdpect.zub is used as input to define the activity distribution.

Simulation of bone-scan using an MDP-like radiopharmaceutical (Whole body)

This example shows the possibility of simulating whole-body studies with the extended Zubal
phantom, which has been developed by Dr Katarina Sjögreen, Lund University. The major
improvement here is that the arms are in a realistic position for WB investigations.
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Figure 3.4: simulation of an MDP-99m-Tc SPECT

simind mdpwb mdpwb1/wb/fa:11 without phantom interactions simind mdpwb mdpwb2/wb/tr:11
with phantom interactions simind mdpwb mdpwb3/wb/tr:11/if add lesions

3.3 ImageJ software

3.3.1 Introduction
ImageJ is a public domain Java image processing program inspired developed at the National
Institutes of Health and the Laboratory for Optical and Computational Instrumentation (LOCI,
University of Wisconsin) [34]. It runs, either as a downloadable application or an online applet,
on any computer with a Java 1.4. Downloadable distributions are available for Microsoft Win-
dows, Mac OS, Mac OS X and Linux. The source code for ImageJ is freely available.In ImageJ
can display, analyze, edit process, save, and print 8-bit, 16-bit and 32-bit (real) grayscale im-
ages and 8-bit and 32-bit color images. 8-bit images are represented using unsigned integers in
the range 0 to 255. 16-bit images use unsigned integers (0 to 65,535) and 32-bit grayscale im-
ages use floating-point numbers.16-bit and 32-bit grayscale images are not directly displayable
on computer monitors, which typically can show only 256 shades of gray. Therefore, the data
are mapped to 8-bits by windowing. The window defines the range of gray values that are dis-
played: values below the window are made black, while values above the window are white. It
can read many image file formats, including TIFF, PNG, GIF, JPEG, BMP, DICOM, and FITS,
as well as raw formats.imageJ, analysis and processing plugin can be developed using ImageJ’s
built-in editor and a Java compiler is possible to solve many image processing and analysis
problems with User-written plugin. ImageJ supports image stacks, a series of images that share
a single window. ImageJ can calculate area and pixel value of user-defined selections and
intensity-thresholded objects. It can measure distances and angles. It can create histograms
and line profile plots. It supports standard image processing functions such as logical and
arithmetical operation between images, contrast manipulation, convolution, Fourier analysis,
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Figure 3.5: Whole body simulation

sharpening, smoothing, edge detection, and median filtering.It does geometric transformations
such as scaling, rotation, and flips. The program supports any number of images simultane-
ously. Image can be zoomed up to 32:1 and down to 1:32. Spatial calibration is available to
provide real world dimensional measurements in units such as centimeters. The calibration of
density or gray scale is also available. ImageJ can made most image processing operations:
viewing and adjusting the grayscale histogram, denoising, lighting correction, Fourier trans-
formation, thresholding, logical operations and arithmetic, and in general, any type of linear
transformation by custom definition of masks.
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3.3.2 Basic concepts
Windows

ImageJ is a floating main window that opens data windows, which are also floating. The main
window contains a menu tool bar, status bar, and a progress bar. Images, line profile, etc. are
displayed in additional windows. Measurement results are displayed in the "Results" window.

Figure 3.6: Window of imageJ

Toolbar

The toolbar contains tools for making selections, for zooming and scrolling images. Mouse
over a tool and a description is displayed in the status bar.

Figure 3.7: Toolbar

Status Bar

The status bar, when the cursor is over an image, displays pixel coordinates and values. After
running a filter, it displays the elapsed time and processing rate in pixels/second. Click on the
status by and it will display (as shown above) the ImageJ version, the Java version, memory in
use, memory available and percent memory used.

Figure 3.8: Status bar

Progress Bar

The progress bar, located to the right of the status bar, shows the progress of time-consuming
operations. It will not appear if the operation requires less then approximately one second.
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Figure 3.9: Progress Bar

Stacks

ImageJ can display multiple spatially or temporally related images in a single window. These
image sets are called stacks. The images that make up a stack are called slices. All the slices
in a stack must be the same size and bit depth. A scroll bar provides the ability to move
through the slices. Most ImageJ filters will, as an option, process all the slices in a stack.
ImageJ opens multi-image TIFF files as a stack, and saves stacks as multi-image TIFFs. The
File>Import>Raw command opens other multi-image, uncompressed files. File>Import>Image
Sequence opens a folder of images as a stack. To create a new stack, simply choose File>New>Image
and set the "Slices" field to a value greater than one. The Image>Stacks submenu contains com-
mands for common stack operations.

Selections

Selections are user defined areas or lines within an image. Area selections are created using the
rectangular, elliptical, polygonal and freehand selection tools. Area selections can be measured
(Analyze>Measure), filtered, filled (Edit>Fill) or drawn (Edit>Draw). Line selections are cre-
ated using the straight, segmented and freehand line selection tools. Use Edit>Draw to draw the
line in the current color. The length of line selections can be measured using Analyze>Measure.
Selections can be moved by clicking and dragging. The status bar displays the coordinates of
the upper left corner of the selection (or the bounding rectangle for non-rectangular selections)
as it is being moved. Notice that the cursor changes to an arrow when it is within the selec-
tion. To move the contents of a rectangular selection, rather than the selection itself, Edit>Copy
(c), Edit>Paste (v), and then click within the selection and drag. Use the arrow keys to nudge
selections one pixel at a time in any direction. Rectangular and elliptical selections can be
resized. As the selection is resized, the width and height are displayed in the status bar. Use
the arrow keys with the alt key down to stretch rectangular or elliptical selections one pixel at
a time. To delete a selection, choose any of the selection tools and click outside the selection,
or se Edit>Selection>Select None (shift-a). Use Edit>Selection>Restore Selection (shift-e) to
restore a selection back after having deleted it. A selection can be transferred from one im-
age window to another by activating the destination window and using Edit>Selection>Restore
Selection. Selections can be saved to disk using File>Save As>Selection and restored using
File>Open. Use the ROI Manager to work with multiple selections.

File Formats

The File>Open command opens TIFF, GIF, JPEG, PNG, DICOM, BMP, PGM and FITS im-
ages. It also opens lookup tables and selections. In addition, the File>Import submenu provides
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access to plugins for reading "raw" files, images in ASCII format, and for loading images over
the network using a URL. To import a raw file, you must know certain information about the
layout, including the image size and the offset to the image data. Files can be saved in TIFF,
GIF, JPEG, PNG, PGM, FITS, tab-delimited text, and raw formats. Add support for additional
formats by downloading or writing plugins. The Bio-Formats plugin from the University of
Wisconsin opens 69 different life sciences image file formats. Plugins ImageJ’s functionality
can be expanded through the use of plugins written in Java. Plugins can add support for new
file formats or they can filter or analyze images. Plugins located in ImageJ’s "plugins" folder
are automatically installed in the Plugins menu or they can be installed in other menus using
Plugins/Hot Keys/Install Plugin. Plugins can be created or modified using Plugins/Edit. More
than 150 example plugins are available for download from the ImageJ website.

Lookup Tables

Grayscale images are displayed using a color lookup table which describes the color to be
used for each of 256 possible displayed pixel values. Select alternative color palettes from the
Image/Lookup Tables submenu. Use Image/Adjust/Brightness/Contrast to enhance images by
dynamically changing the lookup table mapping and Analyze/Show LUT to display the lookup
table of the active image.

3.4 SPECT Correction methods
Energy window methods attempt to estimate the scatter component included in the photopeak
window based on photon acquisition in some other energy windows.

3.4.1 Dual Energy Window (DEW) method
The dual-energy window method assumes that the spatial distribution of the scattered photons
detected in the photopeak window can be estimated as k times the spatial distribution of the
photons detected in a scatter window which is placed over the Compton part of the energy
spectrum [35]

Spk=kTs (3.1)

Where Spk is the scatter projection acquired, Ts is the total projection from the scatter
window. Then, the estimated projection of unscattered photons in the photopeak window, USpk,
can be deduced by

USpk = Tpk − Spk (3.2)

USpk = Tpk − kTs (3.3)

The k value depends on the phantom and imaging situation used. In Jaszczak’s study [8],
two Tc-99m line sources were imaged in air and in a water-filled cylindrical phantom with a
diameter of 22 cm. the k value was optimized to be 0.5 which resulted in a compensated line
source image whose count rates were within 10% of the count rates of the image of the line
source in air.
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3.4.2 Triple energy window (TEW) method using trapezoidal approxi-
mation

In this method [36, 37], it is assumed that the scatter component energy spectrum in the photo-
peak can be estimated by the area of a trapezoid that its left and right heights are equal to the
total number of photons acquired in two narrow energy windows centered on lower- and upper-
edge energies of the photopeak window divided by the width of the window, respectively, that
is:

Csca = (
Cleft

wleft

+
Cright

wright

)
wpk

2
(3.4)

Where Cleft and Crigth denote the total counts detected in the left and right narrow energy
windows, respectively. wpk and w (w= wleft = wrigth ), are the widths of the photopeak and
narrow windows respectively [].

Equation () is applied for each pixel in the photopeak projections to calculate scatter counts.
The calculated scatter counts were subtracted from total counts for each pixel.

Cprim = Ctot − Csca (3.5)

Where Cprim is the total count in the energy window, Ctot the total count and Csca the scatter
count.

3.4.3 Triple energy window (TEW) method using triangular approxima-
tion

In this method [38], instead the trapezoidal area, the spectrum of the scattered counts of the
photopeak window is estimated by the area of a right triangle that its height is equal to the
estimated scatter counts in the left narrow energy window. In this method, it is assumed:
a. There isnt any scattered photon in the narrow window centered on the upper-edge energy of
the photopeak window, and therefore the photons detected in this window are only unscattered
photons:

Cright = USrigth (3.6)

b. and the photopeak is symmetric around the emission energy E0 if there is no scatter:

USleft = USrigth (3.7)

Then the number of scatter counts in the lower narrow window can be estimated as:

Sleft = Cleft − USleft (3.8)

Sleft = Cleft − Cright (3.9)

The number of scattered photons detected in the photopeak is then:

Csca = (
Cleft

wleft

− Cright

wright

)
wpk

2
(3.10)
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3.4.4 Dual-photopeak window (DPW) method
In this correction method [39], Instead of using extra windows next to the photopeak energy
window to estimate the scatter in the photopeak window, the information in the photopeak
window itself can be used. It employs the fact that the lower part of the main energy win-
dow contains more scattered photons than does the upper part. The dual-photopeak window
(DPW) method is split into two abutting non-overlapping energy windows that are symmetri-
cally located around the photopeak energy window and is assumed that for each pixel, there
is a regression relation between the ratio of the scatter counts to the unscatter counts in the
photopeak window, SF, and the ratio of the total counts detected in the lower subwindow to the
upper subwindow, R, as shown in the following equation:

SF = ARB + C (3.11)

Where,

R =
Tlw

Tuw

(3.12)

Tlw and Tuw are the numbers of counts detected in the lower and upper. A, B, and C can be
calibrated by nonlinear regression analysis. It may be obtained from Monte Carlo simulations
or from experimental measurement of point sources in different depths in a water phantom. The
ratio between the two windows is then used to calculate the scatter fraction. The DPW method
assumes that a unique regression relation exists between the SF in the total photopeak window
and the ratio R.

3.4.5 Downscatter (DS) correction method
To correct for downscatter, a window above the main energy window was defined with the same
width as the main energy window. The corrected image was calculated as follows [40]:

Cprim = Ctot − kdsCds (3.13)

Where the subscript kds is used to indicate the downscatter window. To determine kds, a
region of interest outside the phantom was drawn. In the projection data outside the phan-
tom no primary photons are present. In contrast, downscattered photons can be detected if
they penetrate through the septa of the collimator, while it is assumed that they are collimated
perpendicular to the detector surface. Alternatively, they can be backscattered into the crystal
and detected outside the projection of the phantom. Assuming that kds is space invariant (not
depending on position), kds was calculated using the formula:

kds =

∑
Ctot∑
Cds

(3.14)

3.4.6 Channel ratio method
The same two subwindows that split the photopeak window as used in the above method are
used in the channel ratio method. This method [41] assumes that the ratio of the number of

66



Chapter 3. Monte Carlo Simulation

unscattered photons detected in these two subwindows is constant as well as the ratio of the
number of scattered photons:

Ulw

Uup

= G (3.15)

Slw

Sup

= H (3.16)

where U and S stand for unscattered and scattered respectively, lw and uw represent the
lower window and upper window respectively.
The number of counts detected in the lower and upper windows is:

Tlw = Ulw + Slw (3.17)

Tuw = Uuw + Suw (3.18)

Then the estimated number of unscattered photons in the photopeak window can be ex-
pressed by:

Upk =
1 +G

G−H
(Tlw −HTuw) (3.19)

We have recalled in this chapter the principles on which Monophotonic Emission Tomog-
raphy is based, as well as the limits imposed on this modality by many factors. The presence of
the collimator is also an important penalty in terms of spatial resolution and sensitivity. To these
technological limits are added limits due to the physical phenomena of attenuation, diffusion,
variation of the spatial resolution of the camera and measurement noise. The physical origin
and description of these phenomena are given in this chapter and their effects on the quality
and quantification of images are underlined. It is essentially a degradation of the spatial resolu-
tion and the contrast of the reconstructed sections, which lead to errors in the quantification of
images to artefacts, and affect the estimation of reliable dimensions and concentrations. Cor-
rection methods exist for these different physical phenomena and are presented in this chapter.
They can be implemented before or after the reconstruction on the acquired projections or the
reconstructed sections respectively.
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Contributions

4.1 Evaluation of Acceptance Angle in Iodine131 Single Pho-
ton Emission Computed Tomography Imaging with Monte
Carlo Simulation

4.1.1 Introduction
The accurate quantifcation of iodine131 (I131) activity, which is estimated from scintigraphic
images, has great importance because of the recent success of using it in thyroid cancer ther-
apy, as well as in liver cancer therapy.[42] However, quantitative imaging is limited mainly by
the phenomena of scattering and penetration into the septa of a collimator which leads to an
error in the determination of activity. The highest intensity emissions of I131 are 284 (6.1%),
364 (82%), 637 (7.2%), and 723 keV (1.8%).[43] The photons of 637 and 723 keV undergo
only a slight attenuation in the phantom, and they have a higher probability of penetrating the
collimators. They are counted in the window of the photopeak 364 keV. [44, 45, 46] The I131
imaging was evaluated using its 364keV photons. [47] Several methods have been proposed to
correct scattering and septal penetration in I131 imaging. [48, 49, 50] However, no method has
yet been universally successful. The solution is to use a Monte Carlo simulation code such as
simulation Monte Carlo imaging nuclear detector (SIMIND), for scatter and penetration evalu-
ation to develop a method for correcting these events. The aim of this work was to evaluate the
imaging parameters of I131, especially the collimator acceptance angle to obtain the optimum
conditions allowing as much as possible the precise quantifcation of the activity

4.1.2 Materials and Methods
We simulated the Siemens Medical Systems equipped with highenergy collimator using Monte
Carlo simulation SIMIND code version 5.0. We used the following imaging parameters: 0.95
cm NaI (Tl) crystal thickness, intrinsic spatial resolution of 1.2 cm, and energy resolution of
9.80% at 140 keV. The dimension of the crystal was 50c×40 cm. The energy window setting
was 20% at 364 keV. The collimator data used during the simulation are given in Table 1.

A cylindrical water phantom of dimension 22 cm×30 cm×22 cm was placed at 20 cm
from the detector surface. We used the SIMIND Monte Carlo simulation to acquire the data
from I131 point source of 0.005cm diameter located at the center of the cylinder phantom. The
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High energy collimator
Hole diameter (cm) 0.506
Hole length (cm) 5.970
Septal thickness (cm) 0.2
Hole shape Hexagonal
Type of collimation PA

Table 4.1: Design parameters of high energy collimator

images have 0.3cm pixel size and 128 × 128 matrix size. We imported binary images created
by SIMIND in ImageJ software. In this study, we used the acceptance angles to evaluate the
image quality. Photons are isotropically emitted from a point source O, but the photons which
are only propagating within the angle α can be detected [Figure 1]. The angle α can be defned
as the collimator acceptance angle, and it is determined by the ratio of the hole size and length
of the collimator [51] .

α = tan−1(
Holediameter

Holelength
) (4.1)

Figure 4.1: Schematic of acceptance angle

Practically, the acceptance angle α is small to eliminate most of the tilted rays.

4.1.3 Results and Discussion
The contribution of geometric, penetration, and scatter photons was calculated for a point
source at 20 cm from the detector surface as shown in Table 2.

Acceptanceangle (◦) Geometric (%) Penetration (%) Scatter (%)
45 46.42 27.80 25.79

4.845 81.98 14.49 3.53

Table 4.2: Design parameters of high energy collimator
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When the acceptance angle is 45◦, the geometric component is very weak and does not carry
even half of the detected photons. The scattering and penetration components are increased by
the contribution of the 637keV and 723keV photons in the photopeak energy window, and
thus, the geometric photons are decreased. When 4.845◦is used, we notice that the geometrical
component goes up to (82% at 20 cm) that explains why the contribution of the photons of the
upper peaks becomes weak. This is due to small acceptance angle. Figure 2 diagram shows that
blue and green spectra are obtained when the acceptance angles are 45◦and 4.845◦, respectively.

Figure 4.2: Energy spectra for iodine131 source for two acceptance angles values: Blue spectrum (45◦), green
spectrum (4.845◦)

The counts of blue spectrum are more than the one in the green spectrum. That can be ex-
plained by the existence of other peaks of high energies such as 637 keV and 723 keV which can
be detected by the detector after the scattering in the collimator. Hence, the photopeak energy
window in the case of 45◦contains an important part of the scattered photons in comparison to
the case of 4.845◦.

Figure 4.3: Images of a I-131 point source obtained with two acceptances angles: 45◦(a) and 4.845◦(b).

A star like appears in the image of Figure 3a resulted from septal penetration, while this star
is not as clear as the image for Figure 3b. According to Table 3, the best resolution is obtained
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when the distance between the source and the detector is 12 cm fullwidth at halfmaximum
(FWHM = 7.21 mm, fullwidth at tenth maximum [FWTM] =12.36 mm), but the sensitivity
slightly decreases at the same distance. Figure 4 shows that the sensitivity becomes large when
using the 3cm thickness value.

Distance
(cm)

Geometric
(%)

Penetration
(%)

Scatter
(%)

Sensitivity
(Cps/MBq)

FWHM
(mm)

FWTM
(mm)

20 81.98 14.49 3.53 54.24 9.45 16.15
15 79.28 16.83 3.89 55.07 7.9798 14.1678
12 84.75 11.99 3.26 52.36 7.21 12.36

Table 4.3: The results of the simulations at three different distances from the detector

Figure 4.4: Variation of sensitivity with NaI(Tl) crystal thickness.
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4.1.4 Conclusion
In this study, we have evaluated the imaging parameters for I131 using Monte Carlo simulation.
The obtained results show that the image quality ery depends on the acceptance angle. When
its value equal to 4.85◦, the good results were obtained for the geometric component (81.98%)
and the resolution (FWHM = 7.21 mm, FWTM = 12.36 mm).
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4.2 Energy Window and Collimator Optimization in Lutetium177
Singlephoton Emission Computed Tomography Imaging
using Monte Carlo Simulation

4.2.1 Introduction
In recent years, lutetium177 (Lu177) isotope is a promising radionuclide for the treatment of
neuroendocrine tumors and prostate cancer. [52, 53, 54, 55, 56, 57] Lu177 has a therapeutic
betaenergy of 0.5 MeV and two main gammaenergies of 113 and 208 keV (6.1% and 10.3%
yield) used for imaging to evaluate the radiotracer biodistribution. We used only the higher
energy peak because of downscatter from the 208 keV peak into the 113 keV window. Pre-
vious studies were investigated experimentally 20energy window with mediumenergy (ME)
collimator for the 208 keV.[?, 59]] Gamma camera cannot classify the imageforming pho-
tons into primary and scattered photons. Knowledge of scatter distribution is essential for the
optimization of imaging parameters and development of correction method. In this work, we
evaluated three collimators highenergy (HE), Medium energy (ME) and lowenergy high resolu-
tion (LEHR) and 20%, 15%, and 10% energy windows around the 208 keV using the SIMIND
Monte Carlo code .

4.2.2 Materials and Methods
In experimental study, it was not easy to calculate the scattered photon fraction accurately.
Using a Monte Carlo simulation, it was possible to track the photons and hence calculate the
fractions of primary, scattered, and collimatorpenetrated photons. Since high scatter and pene-
tration fraction have deteriorated the image quality, their characterizations give insight into the
effectiveness of the chosen collimator and energy window. In this work, we used Monte Carlo
simulation code to simulate a planar acquisition of the Lu177 point source having 0.05 cm
diameter and located in the center of the cylinder phantom. The dimension of crystal surface
was 59.1×44.5 and had 2.54 cm NaI (Tl) crystal thickness. A waterled cylindricaphantom of
dimension 16cm×22cm×22cm was placed at 15 cm from the detector surface. Three parallel-
hole collimators have been used during the simulation: HE, ME, and LEHR. The collimators
data used during the simulation are given in Table 1. Lutetium177 radiation emission rays are
shown in Table 2. The.

Collimators HE ME LEHR
Hole diameter (cm) 0.506 0.294 0.111

Hole length(cm) 5.970 4.064 2.405
Septal thickness(cm) 0.2 0.114 0.016

Hole shape Hexagonal Hexagonal Hexagonal
Type of collimation PA PA PA

Table 4.4: Design parameters of highenergy, medium energy and Lowenergy high resolution collimators

The Figure 1 shows the geometric used during the simulation. The projections were gener-
ated in matrices of 128 Œ128 pixels, 0.39 cm pixel size. We imported the images created by
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Energy (keV) Abundance(%)
54.61 0.016
55.79 0.027
62.99 0.003
63.24 0.005
64.94 0.002
71.64 0.001
112.95 0.061
208.37 0.103
249.67 0.002
321.32 0.002

Table 4.5: Energies and intensities of gamma rays emitted from Lu177

SIMIND in ImageJ software Institutes of Health and the Laboratory for Optical and Compu-
tational Instrumentation, University of Wisconsin (Bethesda, Maryland, USA).The authors of
the SIMIND have used the deltascattering methods to sample the photon interaction through
the collimators. [60] Therefore, with SIMIND Monte Carlo program, it is possible to calculate
the fractions of geometrical, penetrating, and scattered photons inside the photopeak.

Figure 4.5: Geometry of simulation

4.2.3 Results and Discussion
Figure 2 shows the simulated total energy spectrum of a Lu177 point source in water placed
at 15 cm away from detector surface. The spectrum characteristics will help explaining the
choice of collimator type of imaging. Spatial resolution is an important system property and
was obtained using the point spread function (PSF). In this study, we evaluated the primary and
scattered PSFs for Lu177 singlephoton emission computed tomography (SPECT) imaging. It
varies in shape and magnitude with collimators, as illustrated in Figure 3. It clear that, when
using the ME and LEHR, we obtained a large and similar primary components, while a small
components of this one for HE collimator. In Lu177 SPECT, image quality and quantifcation
accuracy are degraded by scatter and penetration in the collimator.

In this study, we evaluated the geometric, penetration, and scatter component in parallelhole
collimators (HE, ME, and LEHR) for 20%, 15%, and 10% energy windows, respectively, using
Monte Carlo simulation. Figure 3 shows the variation of geometric, penetration, and scatter
component with energy window width in HE, ME, and LEHR collimators, respectively.
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Figure 4.6: The simulated energy spectrum for Lutetium177

Figure 4.7: Primary and scattered point spread functions for highenergy, mediumenergy, and lowenergy high-
resolution collimators

Spatial resolution was obtained using fullwidth half maximum (FWHM) and fullwidth tenth
maximum (FWTM) of the PSF curve. Results for both FWHM and FWTM are shown in Figure
4. It shows that the use of a LEHR collimator would be better for good spatial resolution. The
spatial resolution observed for HE and ME in comparison to LEHR collimator may be due to
the combined effect of larger diameter of the holes (diameter = 0.506 cm for HE and diameter
= 0.294 cm for ME) and increased septa thickness.

As shown in Figure 5, It is clear that the geometric component is large and remains constant
with increase in energy window width collimator produces a weak component of geometric for
the three windows. It suffers from a lot of penetration and scattering from the main emission
peak. Collimators are made mostly of lead materials with a high density and have holes that
allow only those photons traveling along the desired paths to pass through and will determine
the geometrical feld of view. It also essentially determines the sensitivity and

resolution of the system. Collimator sensitivity refers to the percentage of incident photons
that pass through the collimator. Therefore, only a small fraction of emitted photons pass
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Figure 4.8: Fullwidth half maximum and fullwidth tenth maximum of the point source images with highenergy,
mediumenergy, and lowenergy highresolution collimators

Figure 4.9: The variation of geometric, penetration, and scatter component with energy window width for high
energy, medium energy, and low energy highresolution collimators

through the holes and are detected, which seriously limit sensitivity. The sensitivities were
determined by the ratio of the detected counts in the energy window per second per unit activity
(cps/MBq). In this study, we presented the impact of HE, ME, and LEHR collimators on
sensitivity as it affects the image quality in Lu177 SPECT imaging, as illustrated in Table 3.

The sensitivity decreases when the energy window width decreases. The better sensitivity
is recorded by ME collimator with 20% window. Figure 6 shows total and scatter images of
point source obtained as a result of the simulation. The sixfold symmetry of tails is related with
the hexagonalhole shape of the collimator used in the simulation. As shown in Figure 6, the
foggiest image has the highest value of collimator penetration and scatter.
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Energy windows, n (%) HE ME LEHR
20 5.75 8.21 6.26
15 5.20 7.42 5.69
10 4.26 6.08 4.68

Table 4.6: Sensitivity (Cps/MBq) as function of energy windows for highenergy, mediumenergy, and lowenergy
highresolution collimators

Figure 4.10: Total images obtained with highenergy (a), mediumenergy (b), and lowenergy highresolution (c)
collimators. Scatter images with highenergy (d), mediumenergy (e), and lowenergy highresolution (f) collimators

4.2.4 Conclusion
From this study, we believe it should be evident that solely using ME collimator and 20%
energy window is enough to improve Lu177 SPECT image to its fullest extent. The result
provides the optimal collimator and energy window for Lu177 SPECT imaging and will help
the quantifcation of Lu177.
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4.3 Energy window optimization for Y-90 Bremsstrahlung
SPECT imaging: Monte Carlo simulation

4.3.1 Introduction
The short halflife (64.1 h) of the yttrium-90 and its quasi-pure emission of high energy beta
particles. makes it the privileged isotope in targeted radionuclidetherapy for treatment of non-
Hodgkin s lymphoma and unresectable liver cancer [61, 62]. Whereas, the Y90 bremsstrahlung
photons have a continuous and broad energy spectrum, with a high energy (Emax = 2 MeV).

Therefore, the image quality is influenced by the photons detected in the energy window.
Subsequently, the choice of collimator and energy window have a great influence on Y-90
imaging. Pervious works have used Monte Carlo simulation to select the appropriate collimator
and energy window settings for bremsstrahlung SPECT of Y90 [63, 69]. The classification of
photons is done according to their history in the collimator: the geometric photons (photons
passed through a collimator hole), the scatter photons (photons that scatter in the collimator or
in the object) and the penetration photons (photons that penetrated the collimator and that did
not scatter in the collimator or in the object). Moreover, the photons absorbed in the collimator
septa can provide a x-rays component. [70].

Only the geometric photons provide correct positional information. The authors of the
SIMIND Monte Carlo code have used the delta scattering methods to sample the photons in-
teraction through the collimators. Therefore, SIMIND Monte Carlo program can accurately
simulate all interaction of photons inside the collimator. Subsequently, with the Monte Carlo
Simulation technique, accurate assessment of the geometric, penetration and scatter contribu-
tions inside the photopeak window can be made.

Several works have been interested in SIMIND Monte Carlo Simulation program, to de-
termine the different components of the detected radiation. Bremsstrahlung imaging makes
difficult to choose collimator and energy window, hence the optimal clarity of the image is
not always achievable. Therefore, in this work, we used the SIMIND Monte Carlom: code
to estimate the geometric, penetration, and scatter components for parallelhole collimators.
Y90 sensitivity is very low, because approximately 1% of the kinetic energy of the β− parti-
cle is emitted in the form of Bremsstrahlung radiation, which decreases the image quality. To
overcome this problem, i.e. to increase the sensitivity, a large window could be used, but it
includes a large contribution of scattered photons. In this study we choice the six narrow en-
ergy windows and two collimators in order to optimize the tradeoff between the sensitivity and
resolution for Y90 bremsstrahlung imaging.

4.3.2 Materials and methods
In this work, we used the SIMIND (6.2) code to simulate the Siemens Medical System Symbia
equipped with detector having: 0.95 cm NaI(Tl) crystal thickness, intrinsic spatial resolution
of 0.45 cm and energy resolution of 8.80 % at 140 keV. The dimension of the crystal was 59.1
Œ 44.5 cm2. A 0.05cm diameter point source filled with Y-90 (3.7 MBq) was placed at 15 cm
from the detector and located in a cylindrical water phantom (diameter 16 cm, length 32 cm).
Acceptance angle of photons emitted towards the camera was set as 45deg.The pixel size in
the simulated planar source images is 0.34 cm and 128 Œ 128 matrix size. At the end of the
simulation SIMIND code creates a planar image having float values (real *4). We imported
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these images in ImageJ software [18]. In this simulation we included two collimators: Medium
Energy (ME) and High Energy (HE) (Table 1).

Diameter(cm) Septa(cm) Length(cm) Hole shape Collimator type collimator
0.294 0.114 4.064 hexagonal Parallel hole ME
0.400 0.200 5.970 hexagonal Parallel hole HE

Table 4.7: Collimators data

We have chosen six energy windows ranging from 10 keV to 580 keV (Table 2). Figure 1
illustrates the SIMIND simulation of for point source.

Windows (keV) [10.50] [51.120] [121.189] [190.259] [260.329] [330.580]
Center (keV) 30 85 154 224 294 485

Table 4.8: Energy windows used during the simulation

The Figure 1 shows the geometric used during the simulation. The simulated Y-90 images
were quantitatively evaluated using spatial resolution (FWHM, FWTM) for both the HE and
MELP collimators.

Figure 4.11: Geometry of simulation

The SIMIND program has two main programs; CHANGE, which define the system param-
eters and SIMIND, which execute the simulation. Moreover, using CHANGE program, we can
introduce the desired parameters of system. At the end of simulation, SIMIND provide the
value of geometric, penetration, scatter and x-rays component and image in separate files. The
simulated Y-90 images were quantitatively evaluated using spatial resolution (FWHM, FWTM)
for both the HE and ME collimators.

4.3.3 Results
In this study, we evaluated the geometric, septal penetration, scattering components and x-ray
in parallel-hole collimators (ME and HE collimators) using Y-90-point source with six energy
windows ranging from 10keV to 580keV using SIMIND Monte Carlo code. The result of the
simulation is given in Table 3.

Figure 2 shows the variation of geometric, penetration, scatter and x-rays components with
energy window in ME and HE collimators, respectively.
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Collimator Energy window Geometric(%) Penetration(%) Scatter(%) X-ray

ME

[10-50] 63.55 16.28 19 1.1
[51-120] 56.89 17.98 18.59 6.54

[121-189] 32.87 31.77 35.37 0
[191-259] 13.64 48.32 38.04 0
[260-329] 7.33 44.97 47.7 0
[330-580] 2.39 46.47 51.14 0

HE

[10-50] 83.3 5.78 10.22 0.7
[51-120] 72.62 8.6 13.4 5.38

[121-189] 61.17 16.31 22.52 0
[191-259] 32.49 26.12 41.38 0
[260-329] 17.44 32.19 50.37 0
[330-580] 6.03 31.01 62.96 0

Table 4.9: Results of the simulation

The geometric component has decreased with energy window. While, the penetration and
scatter components has increased with increase of energy window. We noted that, the geometric
component reaches 83% for the collimator HE and 63% for the ME in 51-120 keV energy
window. The high penetration and scatter components are due to the large spectrum of Y-90
(up to 2000 kev). It is clear from Figure 2 that the penetration and scatter are a significant
problem for ME making this collimator less useful for imaging. Moreover, even for the HE
collimator, the penetration and scatter effect is also significant. (Figures (3,4)) show images
of Y-90-point source obtained experimentally and by the simulation respectively. The absence
of pronounced photo-peak energy of bremsstrahlung photons is the main reason for a poor
quality of Y-90 point source image (for simulation and experimental) obtained by HE and ME
collimators.

This is evident from the calculated value of high septa penetration and scattering obtained
as a result of the simulation in Table 3. It is important to note that, the foggiest images has
the highest value of penetration and scatter for both collimators. The 6-fold symmetry of tails
is associated with the hexagonal-hole shape of the collimator used in the simulation. The
measured and simulated spatial distribution PSFs of the photons detected in the six-energy
window is shown in Figure 4. To characterize the point source profiles, the FWHM is not
enough because of the presence of tails at the sides of the PSFs; therefore, also the FWTM
must be assessed. The FWHM and the FWTM were computed on the simulated PSFs.

Results for both FWHM and FWTM are shown in Table 4.
The values of the FWHM and FWTM are reported in Figure 5 for the PSFs normalized at

their maximum value. It shows that, the ME collimator increases the FWTM. For all energy
windows, we have found more FWTM (less spatial resolution) for ME in comparison to the HE
collimator. The calculated sensitivities in six energy windows are listed in Table 4.The FWHM
and FWTM were better (FWHM= 7mm, FWTM=35,06mm) in the 51120 keV window than
another window for HE collimator.

The HE sensitivity was lower than ME sensitivity for six energy windows as shown in
Figure 6. The spatial resolution (FWHM= 7mm, FWTM=35,06mm at 51120 keV) observed
with HE collimator is best spatial resolution with consideration of HE sensitivity observed.
The ME collimator gives higher sensitivity and septal penetration. On the other hand, the HE
collimator gives a lower sensitivity and septal penetration.
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Figure 4.12: The variation of geometric component (photons detected on the detector without any scatter or
penetration), penetration component (photons passed through septa without attenuation), scatter (photons that
scatter in the collimator) and x-rays component (photons that are absorbed in the septa collimator) as a function
of the center energy for ME and HE collimators.

4.3.4 Discussion
Scattered and penetration photons through the collimator septal are the degrading effects of
image in the Y-90 bremsstrahlung SPECT imaging.. For a particular selection of collimator,
the fogginess in the images has changed with energy window. The good images quality can
be achieved when using HE collimator. From the profiles, the FWHM and FWTM were deter-
mined and it were found significantly varied with energy windows for both collimators. The
HE collimator offers higher resolution than the ME collimator, for all energy windows. The
Y-90 sensitivity is related to image noise, which can be important for detecting small amounts
of activity. The sensitivity (Cps / MBq) was calculated as the ratio of the total counts in the field
of vision and the acquisition activity. The collimators with parallel holes, the sensitivity and the
spatial resolution have an inverse relationship. A longer hole means better spatial resolution but
low sensitivity. Therefore, a range of collimators is often used to achieve the optimal compro-
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Figure 4.13: Image of the Y-90 point source: obtained experimentally (above images) and by the simulation
(below images) which were obtained in energy window widths:(a,g) 10-50keV, (b,h) 51-120keV, (c,i) 121-189keV,
(d,j) 190-259keV, (e,k) 260-329keV and (f,l) 330-580keV.

Figure 4.14: spread functions (PSFs) vs pixels number: simulation data

mise between sensitivity and resolution. To improve the sensitivity, a large energy window was
used but this can lead to a decrease in resolution. The ME collimator offers higher sensitivity
and lower spatial resolution compared to the HE collimator because the HE collimator reduces

82



Chapter 4. Contributions

Figure 4.15: Point spread functions (PSFs) vs pixels number: experimental data [(30keV-blue); (85keV -green);
(154keV-magenta); (224keV-yellow); (294keV-white) and (485keV-red)]

septal penetration with thicker septa. The determination of collimator and the energy window
for Y-90 imaging are therefore a compromise between sensitivity and spatial resolution.
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Collimator Energy window FWHM(mm) FWTM(mm) Cps/MBq

ME

[10-50] 7.05 36.45 1.27
[51-120] 6 49.03 1.82

[121-189] 5.94 36.92 3
[191-259] 8.26 47.87 1.34
[260-329] 2.19 39.13 0.84
[330-580] 3.36 72.96 2.25

HE

[10-50] 7.42 30.06 0.71v
[51-120] 6.59 35.12 1.63

[121-189] 6.23 28.75 0.78
[191-259] 4.39 29.63 0.4
[260-329] 3.6 20.09 0.21
[330-580] 5.56 35.26 0.9

Table 4.10: FWHM of the point source images

Figure 4.16: spread functions ( Full widths at half of maximum (FWHM) and Full widths at ten of maximum
(FWTM) vs. energy with ME and HE collimators
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Figure 4.17: spread functions (Sensitivity in counts per second per unit activity (Cps/MBq) Vs energy

4.3.5 Conclusion
We evaluated the effect of the parallel hole collimators and energy window on the resolution
and sensitivity using SIMIND Monte Carlo program. The results indicated that the best com-
promise between the sensitivity and resolution was obtained when using an energy window
51-120 keV.
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4.4 Optimization of scatter correction method of Sm-153 at
nuclear medicine using TEW; a Monte Carlo simulation
study

4.4.1 Introduction
In nuclear medicine, Samarium-153 (Sm-153) isotope is potential choice because

, it emits both medium-energy β− particles ( Eβmax = 0.80MeV ) with a short half-life
(46.7 h) and gamma-photons suitable for imaging at 103keV. The physical characteristics
of Sm-153 allow to be considered as excellent radiotherapeutic and diagnostic image agent
[71, 72]. Pervious works [72, 73, 74] demonstrated that, the isotope chelated to ethylene di-
amine tetramethylene phosphonate (EDTMP) is an effective treatment of bone metastases by
the excellent biolocalization. Moreover. Sm-153 is potentially suitable as an alternative to 90Y
in liver cancer treatment with advantage of gamma radiation for imaging [75]. Images obtained
additionally permit be a rapid diagnostic of the therapeutic isotope. In Sm-153 single-photon
emission computed tomography (SPECT) imaging with a gamma camera, the presence of scat-
ter results in introduces significant uncertainty in quantification of activity distribution. The
scattered and primary photons cannot be determined experimentally. While, with the help of
Monte Carlo Simulation, it is possible to track the photons originating from the source that
ultimately deposits its complete energy inside the crystal. It is increasingly used in nuclear
medicine to develop new imaging parameters, scatter correction methods and reconstruction
algorithms. We have used Monte Carlo simulation SIMIND to accurately assess the contri-
bution of scattered photons in the photo-peak window. The quantification of gamma-camera
imaging is improved after the correction of scattered radiation. Previous works [76, 81] were
used TEW (triple energy window) scatter-correction to eliminate the detected scattered counts
inside energy window. In order to quantify emission from the isotope Sm-153 using a gamma
camera accurately, however, it is important to correct the scattered photons which degrade im-
age quality. We can reduce the counts of scattered photons in a photo-peak energy window
using TEW method, which is a simple method to use in Clinical study for SPECT imaging.
However, there are to date no study of measurements of the scatter fraction of Sm-153 as a
function of the energy windows, in order to determine the optimal main- and sub-energy win-
dow for Sm-153 SPECT imaging. In this study, we assessed the fraction of scattered photons
and determined the optimal main and sub-energy windows for triple energy window (TEW)
scatter correction method for Sm-153 by means of Monte Carlo simulation.

4.4.2 Materials and method

4.4.3 Detection system description
In this study, we simulated Siemens Medical System Symbia equipped with low-energy high
resolution (LEHR) (Table1). The images were acquired by a single-head SPECT system (Sym-
bia) based on 103 keV peak. The dimension of detector surface was 59.1cm Œ 44.5cm and
having 2.54cm NaI (Tl) crystal thickness. A water-filled cylinder phantom (diameter 22 cm.
length 32 cm) was placed at 12 cm from the detector surface. We used the SIMIND Monte
Carlo program to acquired data from a Sm-153 point sources of 0.05 cm diameter located in
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different seven positions at the center of the cylinder phantom and offset by ś 5 cm in the X.
Y. and Z directions relative to the center. Moreover, the Jaszak phantom consists of six spheres
with different diameters (31.8, 25.4, 15.9, 19.1, 12.7 and 9.5 mm) which are used to evaluate
the image contrast. Figure 1 illustrates the SIMIND simulation for each point source.

Low Energy High Resolution (LEHR) collimator
Geometric of hole Hexagonal
Length of hole (cm) 5.970
Septal thickness(cm) 0.016
Diameter of hole(cm) 0.111

Table 4.11: Design parameters of (LEHR) collimator

Figure 4.18: Geometry of simulation

We collected 50 millions photons during the simulation. The images had 0.34 cm pixel size
and 128 times 128 matrix size. Figure 2 shows photons energies and intensities of I Sm 153
radionuclide decay.

Figure 4.19: Energies and intensities of gamma rays emitted from the samarium 153 sources
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Energy( keV) 40.90 41.54 47.10 48.38 69.67 75.42 83.36 89.48 97.43 103.18
Abundance 0.166 0.300 0.094 0.024 0.046 0.001 0.002 0.001 0.007 0.292

Table 4.12: Samarium-153 main radiation emission rays.

Monte Carlo simulation

The Monte Carlo simulation SIMIND code , describes a SPECT camera. The SIMIND pro-
gram has two main programs; CHANGE, which define the system parameters and SIMIND,
which execute the simulation. Moreover, using CHANGE program, we can introduce the de-
sired parameters of system. SIMIND accurately simulate all interaction of photons inside the
collimator. At the end of simulation, SIMIND provide the value of geometric, penetration, scat-
ter and x-rays component and image in separate files. We imported binary images created by
SIMIND in ImageJ software [77]. The validation of the SIMIND program for SPECT imaging
has been verified for different gamma camera according to the previous studies [78, 82] [1923].

Triple energy window (TEW) method

The TEW method estimates the counts of the scattered photons in the main photo-peak window
from the counts acquired in two sub-windows on both sides of this window. At each pixel in
planer image, the counts of scattered photons are subtracted from the total counts in photo-peak
window to obtain the count of primary photons. If the measured count is not enough, we can
enlarge the width of the sub-windows. In this study, we used the main-energy windows widths
(10, 15 and 20%) centered on 103 keV and sub-energy windows widths (2, 4 and 6 keV) Table
2.

The true scattered photons fractions for the main energy window calculated by SIMIND
were compared with the scattered photons fraction assumed from TEW scatter-correction method.
The counts of scattered photons and counts of primary photons were calculated by relationships
below [14.15]:

Csac = (
Cleft

Ws

+
Cright

Ws

)
Wm

2
(4.2)

Cprim = Ctot − Csca (4.3)

Where Cleft counts in lower sub-energy window;Cright: counts in upper sub-energy win-
dow; Ws: width of sub-energy window; Wm: width of main window; Ctot:counts in main
window; Csca: scatter counts and Cprim: primary counts. The scatter to total ratio (scatter
fraction) was calculated as Eq.(3) [6]:

S/T =
Csca

Ctot

× 100 (4.4)

The quality of the Sm-153 SPECT image was quantitatively evaluated using the image
contrast assessment. Contrast was calculated by the following formula using Eq.(4):

Contrast =
Ms −Mb

Ms +Mb

(4.5)
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Where, Ms and Mb are the mean pixel values of the activity of spheres and the activity of
background as noise, respectively.

4.4.4 Results
The simulated energy spectrum is shown in Figure 3. The counts acquired in different windows
is shown in Table 3. Table 4 shows the comparison of true scatter fraction (%) and scatter
fraction estimated by TEW scatter correction method at each position. The scatter fraction
depended on the source position in cylindrical phantom. The results showed that; for 20% of the
main energy window and 6 keV sub-energy window of Sm-153, the scatter fraction estimated
by TEW is similar to the true scatter fraction determined by SIMIND. Figure 5 demonstrates
the images for Sm-153 point source at seven positions. The calculated vertical and horizontal
FWHM on the images is shown in Table 5. It shows that, for each position, the TEW method is
decreasing the FWHM. Figure 6 show the reconstructed images of simulated Jaszczak phantom
SPECT before and after scatter correction. It noted that, the contrast of the six spheres was
improved with 20% of the main-energy window and 6 keV sub-energy windows for TEW as
shown in Figure 7. Therefore, 6keV sub-window with a 20% main-energy was possible energy
windows setting for the TEW method in Sm-153.

Figure 4.20: The simulated photon spectrum emitted by the Sm-153.

Table 3 shows the comparison of true scatter fraction (%) and scatter fraction estimated by
TEW scatter correction method at each position. The scatter fraction depended on the source
position in cylindrical phantom. The results showed that; for 20% of the main energy window
and 6 keV sub-energy window of Sm-153, the scatter fraction estimated by TEW is similar to
the true scatter fraction determined by SIMIND.

Figure 3 demonstrates the images for Sm-153 point source at seven positions. The calcu-
lated vertical and horizontal FWHM on the images is shown in Table 4. It shows that, for each
position, the TEW method is decreasing the FWHM.

Figure 4 show the reconstructed images of simulated Jaszczak phantom SPECT before and
after scatter correction. It noted that, the contrast of the six spheres was improved with 20%
of the main-energy window and 6 keV sub-energy windows for TEW as shown in Figure 5.
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Range(keV) Counts
93- 113 11500

113- 115 386
91- 93 1270

113- 117 656
89- 93 2480

113 - 119 822
87 - 93 3600

95 - 111 9660
111 113 544
93 - 95 1330

111 - 115 930
91 - 95 2600

111 - 117 1200
89 - 95 3810

98 - 108 6430
108 - 110 818
96 - 98 1400

108 - 112 1440
94- 98 2790

108 - 114 1900
92 - 98 4060

Table 4.13: The counts acquired in different windows

Figure 4.21: Images for Sm-153 point source at each position in water cylindrical phantom (a) center of water.
(b) Point source offset from center to X-axis (-5 cm). (c) Point source offset from center to X-axis (+5 cm). (d)
Point source offset from center to Y-axis (-5 cm). (e) Point source offset from center to Y-axis (+5 cm). (f) Point
source offset from center to Z-axis (-5 cm). (g) Point source offset from center to Z-axis (+5 cm).

Therefore, 6keV sub-window with a 20% main-energy was possible energy windows setting
for the TEW method in Sm-153.

4.4.5 Discussion
Previous study [82] has assessed the TEW method for Sm-153 SPECT data. But until now,
no study has compared the fraction of scattered photons of Sm-153 with varying main- and
sub-energy windows for the implementation of the TEW method. The scattered photons are
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Window width Position (x,y,z) Simulation(Sca/Tot) TEW (Sca/Tot) Difference (%)
2keV a 4keV 6keV 2keV 4keV 6keV

20% (0,0,0) 36 51.39 50.14 49.04 29.95 -2.50 -2.25
(-5,0,0) 37 51.79 50.24 48.94 28.56 -3.09 -2.65
(5,0,0) 37 47.71 46.19 45.53 22.45 -3.30 -1.44
(0,-5,0) 31 43.35 40.99 40.38 28.49 -5.75 -1.52
(0,5,0) 31 47.85 46.50 44.28 35.21 -2.90 -5.02
(0,0,-5) 47 52.41 52.93 51.68 10.32 0.98 -2.42
(0,0,5) 20 38.86 36.57 36.52 48.54 -6.27 -0.15

15% (0,0,0) 33 46.46 44.83 43.72 28.98 -3.65 -2.55
(-5,0,0) 34 49.29 46.50 44.83 31.01 -6.00 -3.72
(5,0,0) 34 50.99 45.74 43.15 33.31 -11.47 -6.00
(0,-5,0) 28 45.70 41.03 38.09 38.73 -11.39 -7.70
(0,5,0) 28 45.70 42.47 40.84 38.73 -7.59 -4.01
(0,0,-5) 45 44.86 51.40 49.65 -0.30 12.71 -3.51
(0,0,5) 17 57.58 36.22 33.74 70.48 -58.99 -7.35

10% (0,0,0) 29 69.02 59.96 114.79 57.98 -15.11 47.77
(-5,0,0) 29.1 68.34 88.98 106.79 57.42 23.19 16.68
(5,0,0) 29.5 68.39 90.59 107.51 56.87 24.50 15.74
(0,-5,0) 23.6 66.37 86.68 101.14 64.44 23.43 14.30
(0,5,0) 24.5 65.01 85.17 100.72 62.31 23.68 15.43
(0,0,-5) 40.7 73.10 97.20 118.73 44.32 24.80 18.13
(0,0,5) 14.5 61.58 77.95 89.87 76.45 21.00 13.26

Table 4.14: Comparison of simulated scatter fraction (%) and scatter fraction estimated using TEW scatter
correction method for different main- and sub-windows.

Figure 4.22: The reconstructed images of simulated Jaszczak; (a) without the TEW image, (b) Scatter image,
(c) with the TEW image.

a major factor degrade resolution image and image contrast [?]. The resolution is mostly ex-
pressed as the full width at half of maximum (FWHM) of the PSF. A smaller FWHM imply the
better quality of the image. The FWHM and contrast were utilized to assess the effect of the
processing method on image quality. The choice of optimal energy window in TEW method
has a key role which appearing the lowest scatter fraction. We have determined the optimal
windows that it display the similar scatter fraction calculated by means of simulation and TEW
method. Different scatter fractions were obtained for each source location. There was a smaller
difference with 20% main-energy window and 6 keV secondary energy window. By looking
at the Table 4, it is obvious that the calculated the spatial resolution was improved with TEW
method. As shown in Figure 5, the 20% main-energy window with 6 keV sub-energy windows
produce the better contrast when using the TEW correction. The simplicity of this method
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Source position (x,y,z) Without TEW ) With TEW )
X FWHM(mm) Y FHM(mm) X FWHM(mm) Y FWHM(mm)

(0,0,0) 9.73 9.51 3.47 3.47
(-5,0,0) 9.65 9.42 7.95 7.24
(5,0,0) 9.62 9.51 7.08 7.21
(0,-5,0) 9.47 9.29 7.00 7.24
(0,5,0) 9.60 9.29 7.52 7.79
(0,0,-5) 12.19 11.98 8.90 8.52
(0,0,5) 7.68 7.46 6.67 5.10

Table 4.15: FWHM of the point source images of Figure 3

Figure 4.23: Calculated contrast of six hot spheres (S1, S2, S3, S4, S5 and S6) with different diameters: (31.8,
25.4, 15.9, 19.1, 12.7 and 9.5mm) respectively.

making it feasible in Clinical study. However, the estimation of scattered photons cannot be
determined experimentally, with the help of Monte Carlo simulation, accurate assessment of
the scattered photon fractions inside photo-peak window can be made.

4.4.6 Conclusion
In this study, we used the Monte Carlo SIMIND code with triple energy window scatter cor-
rection method to correct the scatter events detected in photo peak window for Sm-153. The
results indicate that, it is better to use 20% main photo-peak window with 6 keV sub- windows
when TEW method is applied.
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General conclusion
The results from the Monte Carlo simulation indicate that this technique can be useful for de-
termination and evaluation of imaging parameter because of its capability to differentiate the
events into separate components. Important parameters, such as the scatter-to-total ratio and
primary-to-total ratio, can then be determined and serve as an aid when developing correc-
tion methods for scatter and septal penetration. The SIMIND Monte Carlo code used in this
work includes complete modeling of collimator interactions, which is essential when higher
energy photon emitters are simulated. The following conclusions can be drawn from this the-
sis: We have evaluated the imaging parameters for I 131 using Monte Carlo simulation. We
showed that, in I-131 SPECT, the collimator scatter and penetration are significant and our re-
sults demonstrates that, the small acceptance angle has a major effect on the image quality in I
131 SPECT imaging. We used Monte Carlo simulation to perform detailed characterization of
spatial distributions of photons that undergo scatter and septal penetration in Lu-177 imaging.
This characterization will be useful for development of new techniques and evaluation of ex-
isting method that correct for scatter and penetration in Lu-177 SPECT imaging. The obtained
optimal ME collimator and optimal 20% energy window have the potential to improve the im-
age contrast of Lu-177 images. Subsequently, high quality Lu-177 images can provide reliable
estimate of the Lu-177 activity distribution.
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Résumé 
Les simulations de Monte Carlo sont actuellement considérées en imagerie de médecine nucléaire comme un 

outil pour concevoir et optimiser la caméra à scintillation et les systèmes SPECT, ainsi que pour évaluer 

algorithmes de reconstruction et méthodes de correction pour dégrader les effets physiques. Parmi les de 

nombreux simulateurs disponibles, aucun d'entre eux n'est considéré comme un standard en imagerie médicale 

nucléaire. Dans cette thèse, nous avons utilisé le code de simulation de Monte Carlo, SIMIND, qui décrit une 

caméra SPECT standard et peut facilement être modifié pour presque n'importe quel type de calcul rencontré en 

imagerie SPECT. SIMIND a été validé dans SPECT en modélisant des gamma caméras, en comparant les 

résultats obtenus avec des simulations SIMIND avec des données expérimentales. SIMIND comprend une 

modélisation complète des interactions des collimateurs, ce qui est essentiel lorsque des émetteurs de photons de 

plus haute énergie sont simulés. Notre objectif dans ce travail de thèse était d'évaluer et de déterminer les 

paramètres d'imagerie optimaux en imagerie SPECT, et également d'évaluer la méthode TEW, au moyen de la 

simulation de Monte Carlo. Une méthode largement utilisée pour la correction de la diffusion est la soustraction 

d'images formées à l'aide de fenêtres d'énergie dans la région des photopointes. Les paramètres utilisés pour la 

comparaison des différents paramètres de fenêtre et collimateurs incluent; résolution spatiale, sensibilité, 

contraste de l'image, rapports diffusion / total (STR). Nous avons évalué les paramètres d'imagerie pour l'I-131 

en utilisant la simulation de Monte Carlo. Nous avons démontré que, dans I-131 SPECT, la diffusion et la 

pénétration du collimateur sont significatives et nos résultats montrent que, le petit angle d'acceptation a un effet 

majeur sur la qualité de l'image en imagerie I-131 SPECT. En outre, un certain nombre de paramètres de fenêtre 

d'énergie et de collimateur différents pour les isotopes I-131, Lu-177, Y-90 sont étudiés en utilisant des 

simulations de Monte Carlo avec le code SIMIND. De plus, nous évaluons les fractions de photons diffusés et 

déterminons les fenêtres optimales de sous-énergie et d'énergie principale pour la mise en œuvre de la méthode 

de correction TEW en imagerie Sm-153. 

Mots-clés: tomographie par émission monophotonique (SPECT), imagerie nucléaire, Monte Simulation de 

Carlo, SIMIND, sensibilité, résolution spatiale, photon diffusé 

 

Abstract 
Monte Carlo simulations are currently considered in nuclear medicine imaging as a powerful 

tool to design and optimize the scintillation camera and SPECT systems, and also to assess 

reconstruction algorithms and correction methods for degrading physical effects. Among the 

many simulators available, none of them is considered as a standard in nuclear medical imaging. In 

this thesis we have used the Monte Carlo simulation code, SIMIND, which describes a standard 

SPECT camera and can easily be modified for almost any type of calculation encountered in SPECT 

imaging. SIMIND was validated in SPECT by modeling gamma cameras, by comparing the results 

obtained with SIMIND simulations with experimental data. SIMIND includes complete modeling of 

collimator interactions, which is essential when higher energy photon emitters are simulated. Our 

objective in this thesis work was to evaluate and determine the optimal imaging parameters in SPECT 

imaging, and also evaluate of TEW method, by the means of Monte Carlo simulation. A widely used 

method for scatter correction is subtraction of images formed using energy windows in the region of 

the photopeaks. Parameters used for comparison of the different window settings and collimators 

include; spatial resolution, sensitivity, image contrast, scatter to total ratios (STR). We have evaluated 

the imaging parameters for I-131 using Monte Carlo simulation. We demonstrated that, in I-131 

SPECT, the collimator scatter and penetration are significant and our results show that, the small 

acceptance angle has a major effect on the image quality in I-131 SPECT imaging. In addition, a 

number of different energy window settings and collimator for the isotopes I-131, Lu-177, Y-90 are 

investigated using Monte Carlo simulations with the code SIMIND. Also, we assess the scattered 

photon fractions and determined the optimal sub- and main-energy windows for the implementation of 

TEW correction method in Sm-153 imaging. 

Keywords: single-photon emission computed tomography (SPECT), nuclear imaging, Monte 

Carlo simulation, SIMIND, sensitivity, spatial resolution, scattered photon 
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